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บทคัดยอ 

 

 โครงงานเลมน้ีจัดทําขึ้นเพื่อนําความรูที่ไดศึกษามาในสาขาวิชาเทคโนโลยีสารสนเทศ 

มาประยุกตใชในการจัดทําโครงการ ผูจัดทําโครงการไดแสดงความเห็นเปนแนวทางเดียวกัน 

วาจะจัดทําโครงงานเลมน้ีในเร่ือง “เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล” ใชโปรแกรม 

Arduino IDE เพื่อเขียนโปรแกรมควบคุม Arduino Arduino เพื่อนําไปควบคุมอุปกรณ

อิเล็กทรอนิกสในการใชงานดานตาง ๆ แตเน่ืองจากการพัฒนาของเทคโนโลยีในปจจุบันมี

ความกาวหนาอยางรวดเร็ว จึงทําใหชุดซอฟตแวรและอุปกรณอิเล็กทรอนิกสมีการพัฒนามากยิ่งขึ้น

มีความทันสมัยใชงานงาย และมีใหเลือกอยางหลากหลายโปรแกรมที่ใชงานและสามารถนํามา

พัฒนาและประยุกตใชไดอยางหลากหลาย 

 ทําใหเกิดแนวคิดในการจัดทําเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล ที่สามารถแจง

เตือนขณะมีแกสร่ัวไหล สามารถแสดงผานทางจอภาพถึงระดับของแกสที่ร่ัวไหลออกมา สามารถ

เลือกระดับปริมาณของแกสที่จะทําการแจงเตือนและสามารถแกไขปญหาการร่ัวไหลของแกสได

ทันเวลา ซึ่งการทํางานทั้งหมดน้ันจะถูกควบคุมโดย Arduino 

จากการศึกษาและสืบคนขอมูลกอนการลงมือปฏิบัติทางคณะผู จัดทําไดรับความรู 

ในเร่ืองตาง ๆ และยังไดรับประสบการณนอกหองเรียนเปนอยางมากทางคณะผูจัดทําจึงหวัง 

เปนอยางมากวาโครงการเลมนน้ีจะมีประโยชนตอผูพบเห็นไมมากก็นอยตามความเหมาะสม 

 



II 

กิตติกรรมประกาศ 

 

โครงการฉบับน้ีสําเร็จลุลวงไดอยางดีและไดรับความเมตตาจากอาจารย คุณานนท สุขเกษม

และอาจารย สุธารัตน ทองใหม ที่ไดใหคําแนะนํา และคําปรึกษา เกี่ยวกับเคร่ืองตรวจจับและแจง

เตือนแกสร่ัวไหล Gas leak detecdor and alarm มาโดยตลอด ผูทําโครงการรูสึกซาบซึ้ง ในความ

อนุเคราะหจากทานเปนอยางมาก และกราบขอบพระคุณเปนอยางสูง  

ผูทําโครงการขอกราบขอบพระคุณ บิดา มารดา และเพื่อน ๆ พี่ ๆ ที่ใหกําลังใจและใหโอกาส

บุตรไดรับการศึกษาในระดับตาง ๆ จนกระทั่งไดสําเร็จการศึกษาระดับประกาศนียบัตรวิชาชีพ

ชั้นสูง รวมทั้งคณะอาจารยทุกทานในสาขาวิชาเทคโนโลยีสารสนเทศ ที่ไดประสิทธิ์ประสาท 

วิชาความรูและคําสั่งสอน ใหกับผูทําโครงการในการเรียนทุกระดับชั้น  

ขอขอบพระคุณครอบครัวที่ใหการชวยเหลือในทุก ๆ ดาน จนทําใหประสบความสําเร็จ 

ลุลวงไปไดดวยดี ขอบคุณเพื่อนๆ พี่ ๆ ทุกคน ในสาขาเทคโนโลยีสารสนเทศ วิทยาลัยเทคโนโลยี 

อรรถวิทยพณิชยการ ที่คอยใหการชวยเหลือการทําโครงการฉบับน้ี  

สุดทายความรูและประโยชนที่ไดรับจากโครงการฉบับน้ี ผูทําโครงการ ขอมอบความดี

ความชอบ ที่ไดน้ีใหแกผูมีพระคุณทุกทาน 

 

ธีรพงศ ธูปขุนทด 

ไชยรัตน จากรัมย 
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บทท่ี 1 

บทนํา 

 

1.1  ความเปนมาและความสําคัญของปญหา 

       ในอดีตที่ผานมามีการใชคอมพิวเตอรเพื่อนํามาใชงานดานตาง ๆ อยางแพรหลาย และ 

ใชโปรแกรม Arduino IDE เพื่อเขียนโปรแกรมควบคุม Arduino เพื่อนําไปควบคุมอุปกรณ

อิเล็กทรอนิกส ในการใชงานดานตาง ๆ แตเน่ืองจากการพัฒนาของเทคโนโลยีในปจจุบันมี

ความกาวหนาอยางรวดเร็ว จึงทําใหชุดซอฟตแวรและอุปกรณอิเล็กทรอนิกสมีการพัฒนามากยิ่งขึ้น

มีความทันสมัยใชงานงาย และมีใหเลือกอยางหลากหลายโปรแกรมที่ใชงานและสามารถนํามา

พัฒนาและประยุกตใชไดอยางหลากหลาย 

       เปนที่ทราบกันดีอยูแลววา ความปลอดภัยน้ันเปนสิ่งสําคัญตอการดําเนินชีวิต ในปจจุบันระบบ

รักษาความปลอดภัยไดเขามามีบทบาทสําคัญในการปองกันอุบัติเหตุที่จะเกิดขึ้นอยางไมคาดคิด 

ควบคูไปกับเทคโนโลยีที่กําลังจะถูกพัฒนาอยางไมหยุดน่ิง เพื่อลดความสูญเสียที่จะเกิดข้ึนจาก

ปญหาที่พบแกสร่ัวไหลอาจนํามาสูการเกิดเพลิงไหม เกิดการระเบิด ซึ่งทําใหเกิดความสูญเสีย เสีย

ทรัพยสิน เสียทรัพยากร หรืออาจถึงขั้นเกิดการเสียชีวิต ทําใหเกิดแนวคิดในการจัดทําเคร่ืองตรวจ

จับและแจงเตือนแกสร่ัวไหล ที่สามารถแจงเตือนขณะมีแกสร่ัวไหล สามารถแสดงผานทางจอภาพ

ถึงระดับของแกสที่ร่ัวไหลออกมา สามารถเลือกระดับปริมาณของแกสที่จะทําการแจงเตือนและ

สามารถแกไขปญหาการร่ัวไหลของแกสไดทันเวลา ซึ่งการทํางานทั้งหมดน้ันจะถูกควบคุมโดย 

Arduino หลักการทํางานของชุดอุปกรณเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลจะทํางานโดย

เขียนชุดคําสั่งใหโปรแกรมทํางานผาน Arduino เพื่อใหควบคุมอุปกรณเคร่ืองตรวจจับและแจงเตือน

แกสร่ัวไหล ใหทํางานตามความตองการของผูใช ซึ่งโปรแกรมในปจจุบันน้ีถูกพัฒนาขึ้นมาเพื่อ

ตอบสนองความตองการในการใชงานของมนุษยมากที่สุดและมีประสิทธิภาพในการใชงานสูงสุด 

และใชงานงายกวาโปรแกรมในอดีต 

       จึงมีการนําเสนอโครงการเร่ืองเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล เน่ืองจาก   ผูเสนอ

โครงการพบปญหาที่เกิดขึ้นจึงมีแนวคิดที่จะพัฒนาเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลน้ีให

สามารถตรวจจับปริมาณแกสไดมีการแสดงผลทางจอ LCD และมีลําโพงแจงเตือนคณะผูจัดทํา

โครงการน้ีมีความตองการที่จะพัฒนาตอยอดใหชิ้นงานน้ันมีประสิทธิภาพที่ดีขึ้นและเสริมสราง

ทักษะทางดานการเขียนโปรแกรมของคณะผูจัดทําและดานความคิดสรางสรรคในดานการ

ออกแบบโครงสรางของชิ้นงาน ทําใหผูจัดทํามีประสบการณและเสริมสรางทักษะทั้งใน 

ดานซอฟตแวรและฮารดแวร ไปพรอม ๆ กัน สงเสริมใหมีความเชียวชาญมากขึ้นมีไหวพริบในการ

แกไขปญหาเฉพาะหนามีความรับผิดชอบ และเปนการสงเสริมใหหันมาสนใจทางดานฮารดแวร

มากยิ่งขึ้น 
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1.2  วัตถุประสงคของโครงการ 

  1. เพื่อศึกษาสถานการณทํางานของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

  2. เพื่อนําเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลมาใชประโยชนไดจริง 

  3. เพื่อสรางความปลอดภัยใหกับสถานที่ที่มีเคร่ืองมือหรือเคร่ืองใชที่บรรจุแกส 

  4. เพื่อปองกันการเกิดอัคคีภัย 

 

1.3  ขอบเขตของโครงการ  

  1. ตรวจจับแกสผานอุปกรณ MQ-2 

         2. แสดงคาแกสที่ตรวจจับไดในจอแสดงผล LCD หนวยวัดคาแกส คือ PPM  

  3. สามารถกําหนดคาแกสที่จะใหอุปกรณสงสัญญาณแจงเตือนผานโปรแกรม Arduino 

IDE 

  4. เมื่อแกส มาโดนบริเวณ Sensor ตรวจจับแกส จะมีการสงสัญญาณ analog ไปยัง Arduino 

หากมีความหนาแนนของ แกส ก็จะมีคา analog ที่สูงขึ้นสงไปยัง Arduino เมื่อ Arduino รับสัญญาณ

จาก Sensor ถาคาแกสมีคาตํ่ากวาที่กําหนดไฟสีเขียวจะสวาง ถามีคาแกสตรงตามที่กําหนด หรือเกิน

กวาที่กําหนดไฟสีแดงจะสวางเพื่อเตือนวาไมปลอดภัย 

  5. เมื่อคาแกสเทากับหรือมากกวาคาที่กําหนด อุปกรณจะสงสัญญาณเสียงแจงเตือนดังขึ้น 

เพื่อเตือนวาไมปลอดภัย 

 

1.4  ข้ันตอนการดําเนินงาน 

  1. คิดหัวขอโครงการ  

  2. จัดทารูปเลมเสนอรางโครงการ  

  3. เสนอรางโครงการ  

  4. แกไขเสนอรางโครงการ  

  5. สงเสนอรางโครงการที่แกไขแลว  

  6. ศึกษาคนควาขอมูลเกี่ยวกับบอรดArduinoและชุดซอฟตแวรที่จะใชควบคุม  

  7. วางแผนการทํางานกระจายงานแบงการทํางานเปนสวน ๆ  

  8. จัดทําโครงการ สรางเคร่ืองมือและรวบรวมขอมูล 

  9. ทดลองใชเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

  10. แกไขปรับปรุงเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

  11. นําเสนอโครงการ 

  12. จัดทําเอกสารโครงการ 
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1.5  ระยะเวลาการทําโครงการ 

ตารางที่ 1.1 ตารางแผนการดําเนินงาน 

  

ลํา

ดับ 
ข้ันตอนการดําเนินงาน 

ระยะเวลาการดําเนินงาน 

ป พ.ศ. 2562 
ป พ.ศ. 

2563 

มิ.ย ก.ค ส.ค ก.ย ต.ค พ.ย ธ.ค ม.ค ก.พ 

1 คิดหัวขอโครงการ          

2 จัดทําเอกสารแบบเสนอราง

โครงการ 

         

3 เสนอรางโครงการ          

4 แกไขเสนอรางโครงการ          

5 สงเสนอรางโครงการที่แกไข

แลว 

         

6 ศึกษาคนควาขอมูลเกี่ยวกับ

บอรดArduinoและชุด

ซอฟตแวรที่จะใชควบคุม 

         

7 วางแผนการทํางานกระจาย

งานแบงการทํางานเปนสวน ๆ 

         

8 จัดทําโครงการ สรางเคร่ืองมือ

และรวบรวมขอมูล 

         

9 ทดลองใชเคร่ืองตรวจจับและ

แจงเตือนแกสร่ัวไหล 
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1.6  ประโยชนท่ีคาดวาจะไดรับ 

  1. ลดความเสี่ยงที่จะเกิดอัคคีภัยในสถานที่ที่มีเคร่ืองมือหรือเคร่ืองใชที่บรรจุแกส 

  2. เพิ่มความปลอดภัยในชีวิตและทรัพยสิน 

  3. ไดเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลที่สามารถใชงานไดจริง 

 

1.7  งบประมาณท่ีใชในการทําโครงการ 

  1. Sensor MQ-5 100 บาท 

  2. ตัวตานทาน คาความตานทานที่ 220 Ohm 20   บาท 

  3. LCD Display 200 บาท 

  4. Arduino UNO 450 บาท 

  5. ลําโพงขนาดเล็ก (Buzzer) 40   บาท 

  6. หลอดไฟ LED สีเขียว สีแดง 80   บาท 

  7. สายไฟ ชนิด Male to Male  40   บาท 

  8.  สายไฟ ชนิด Male to Female 40   บาท 

  9. โฟโตบอรด 100 บาท 

  10. คาทําเลมเอกสาร 500 บาท 

  รวม  1570  บาท 

ตารางที่ 1.1 (ตอ) ตารางแผนการดําเนินงาน 

10 แกไขปรับปรุงเคร่ืองตรวจจับ

และแจงเตือนแกสร่ัวไหล 

         

11 นําเสนอโครงการ          

12 จัดทํารูปเลมโครงการทั้งหมด          
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บทที่  2 

เอกสารและทฤษฎีที่เก่ียวของ 

 

 ในการจัดทําโครงการ เร่ืองเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล คณะผูจัดทําไดศึกษา

เอกสาร เคร่ืองมือและผลงานที่เกี่ยวของ ซึ่งนับวาเปนองคประกอบที่สําคัญ จะทําใหโครงการมี

ความครบถวนสมบูรณมากยิ่งขึ้น คณะผูจัดทําไดแบงขอมูลที่เกี่ยวของเปนหัวขอดังน้ี 

 2.1 Sensor MQ-5 

 2.2  ตัวตานทาน คาความตานทานที่ 220 Ohm 

 2.3  LCD Display 

 2.4  Arduino UNO 

 2.5  ลําโพงบัซเซอร (Buzzer) 

 2.6  หลอดไฟ LED สีเขียว สีแดง 

 2.7  สายไฟ ชนิด Male to Male อยางละ 10 เสน 

 2.8  สายไฟ ชนิด Male to Female อยางละ 10 เสน 

 2.9  การใชงานโปรแกรม Arduino IDE 

 2.10  หลักการเขียนโปรแกรม Arduino 

 2.11 ความรูเบื้องตนเกี่ยวกับกาซปโตรเลียมเหลว LPG  
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2.1  เซ็นเซอร (Sensor) 

 

รูปท่ี 2.1 เซ็นเซอร (sensor)  ที่มา  (https://www.google.com/search?q=sensor) 

 

          ตัวรับรู หรือ เซ็นเซอร (อังกฤษ: sensor) เปนวัตถุชนิดหน่ึงที่มีหนาที่ตรวจจับเหตุการณหรือ

การเปลี่ยนแปลงของสภาพแวดลอมของตัวมันเอง จากน้ันมันก็จะใหผลลัพธที่สอดคลองกันออกมา 

ตัวรับรูเปนตัวแปรสัญญาณ (อังกฤษ: transducer) ชนิดหน่ึง มันสามารถใหสัญญาณออกมาได

หลากหลายชนิด แตโดยทั่วไปจะใชสัญญาณไฟฟาหรือสัญญาณแสง ยกตัวอยางเชนคูควบความ

รอน (อังกฤษ: thermocouple) จะแปลงคาอุณหภูมิ(สิ่งแวดลอม)ใหเปนแรงดันไฟฟาที่สอดคลอง

กัน ในทํานองที่คลายกัน เทอรมอมิเตอรแบบปรอทในหลอดแกวจะเปลี่ยนอุณหภูมิที่วัดไดใหอยูใน

รูปการขยายตัวหรือการหดตัวของของเหลว ซึ่งสามารถอานไดบนหลอดแกวที่ผานการสอบเทียบ

แลว ตัวรับรูทุกชนิดจะตองผานการสอบเทียบ (อังกฤษ: calibrate) โดยเทียบกับคามาตรฐานที่เปน

ที่ยอมรับ 

          ตัวรับรูถูกใชในอุปกรณประจําวัน เชนปุมกดลิฟตแบบไวตอการสัมผัส(เซ็นเซอรสัมผัส) 

และโคมไฟที่สลัวหรือสวางขึ้นโดยการสัมผัสที่ฐาน นอกจากน้ียังมีการใชงานเซ็นเซอรนับไมถวน

ที่ ค น ส ว น ใ หญ ไ ม ไ ด รั บ รู  ด ว ย ค ว า ม ก า ว หน า ท า ง เ ค ร่ือ ง ก ล จุ ล ภ า ค แ ล ะ แ พ ล ตฟ อ ร ม

ไมโครคอนโทรลเลอรที่งายตอการใชงาน การใชงานของตัวรับรูไดขยายออกไปไกลเกินกวาการวัด

ในสาขาอุณหภูมิ, ความดันหรือการไหลแบบเดิมสวนมาก ยกตัวอยางเชน MARG (Magnetic, 

Angular Rate, and Gravity) sensors ยิ่งไปกวาน้ัน ตัวรับรูแบบแอนะล็อคเชนโปเทนฉิโอมิเตอร

และตัวตานทานที่ไวตอแรงยังคงถูกใชอยูอยางกวางขวาง การใชงานจะรวมถึงการผลิตและ

เคร่ืองจักร, เคร่ืองบินและยานอวกาศ, รถยนต, เคร่ืองไฟฟา, การแพทย, และหุนยนต มันยังรวมถึง

ในชีวิตประจําวัน 
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          ความไวของตัวรับรูหมายถึงวาสัญญาณสงออกของตัวรับรูจะเปลี่ยนแปลงมากแคไหน 

เมื่อปริมาณของสัญญาณที่ปอนเขาเพื่อทําการวัดมีการเปลี่ยนแปลง ตัวอยางเชนถาปรอทใน 

เทอรมอมิเตอรเคร่ืองไหวไป 1 ซม. เมื่ออุณหภูมิเปลี่ยนไป 1 องศาเซลเซียส ดังน้ันความไวจะมีคา

เปน 1 เซนติเมตร/°C (สมมติวาสโลป Dy/Dx มีลักษณะเปนเชิงเสน) ตัวรับรูบางตัวยังอาจมี

ผลกระทบกับสิ่งที่มันวัด; เชนเทอรมอมิเตอรที่อุณหภูมิหองถูกใสลงในถวยรอนที่ใสของเหลว

ความเย็นของเทอรมอมิเตอรจะทําใหของเหลวเย็นลงในขณะที่ของเหลวทําใหเทอรมอมิเตอรรอน

ข้ึน ตัวรับรูจําเปนจะตองมีการออกแบบเพื่อใหมีผลขนาดเล็กกับสิ่งที่ถูกวัด; การทําใหตัวรับรูมี

ขนาดเล็กลงมักจะปรับปรุงใหดีขึ้นในเร่ืองน้ีและอาจทําใหเกิดขอไดเปรียบอ่ืน ๆ [อางจําเปน]

ความกาวหนาทางเทคโนโลยีจะชวยใหมีการสรางตัวรับรูอ่ืน ๆ มากขึ้นอีกมากมายในขนาดจุลภาค

เชนไมโครเซนเซอรโดยใชเทคโนโลยี MEMS (Microelectromechanical systems) ในหลายกรณี

สวนใหญไมโครเซนเซอรจะมีความเร็วและความไวที่สูงขึ้นอยางมีนัยสําคัญเมื่อเทียบกับกรรมวิธี

แบบมหภาค 

 

2.2  ตัวตานทาน (Resistor) 

 

รูปท่ี 2.2 ตัวตานทาน (Resistor)  ที่มา  (https://www.google.com/search?q=Resistor) 

 

 ตัวตานทาน หรือ รีซิสเตอร (อังกฤษ: resistor) เปนอุปกรณไฟฟาชนิดหน่ึงที่มีคุณสมบัติ

ในการตานการไหลผานของกระแสไฟฟา ทําดวยลวดตานทานหรือถานคารบอน เปนตน น่ันคือถา

อุปกรณ น้ันมีความตานทานมาก กระแสไฟฟาที่ ไหลผานจะนอยลง เปนอุปกรณไฟฟา 
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ชนิดพาสซีฟสองขั้ว ที่สรางความตางศักยไฟฟาครอมขั้วทั้งสอง (V) โดยมีสัดสวนมากนอยตาม

ปริมาณกระแสไฟฟาที่ไหลผาน (I) อัตราสวนระหวางความตางศักย และปริมาณกระแสไฟฟา ก็คือ

คาความตานทานทางไฟฟา หรือคาความตานทานของตัวนํามีหนวยเปนโอหม ( สัญลักษณ : Ω ) 

เขียนเปนสมการตามกฏของโอหม ดังน้ี 

 คาความตานทานน้ีถูกกําหนดวาเปนคาคงที่สําหรับตัวตานทานธรรมดาทั่วไปที่ทํางาน

ภายในคากําลังงานที่กําหนดของตัวมันเอง 

 ตัวตานทานทําหนาที่ลดการไหลของกระแสและในเวลาเดียวกันก็ทําหนาที่ลดระดับ

แรงดันไฟฟาภายในวงจรทั่วไป Resistors อาจเปนแบบคาความตานทานคงที่ หรือคาความตานทาน

แปรได เชนที่พบใน ตัวตานทานแปรตามอุณหภูมิ(อังกฤษ: thermistor), ตัวตานทานแปรตาม

แรงดัน(อังกฤษ: varistor), ตัวหร่ีไฟ(อังกฤษ: trimmer), ตัวตานทานแปรตามแสง 

(อังกฤษ:photo resistor) และตัวตานทานปรับดวยมือ(อังกฤษ: potentiometer) 

 ตัวตานทานเปนชิ้นสวนธรรมดาของเครือขายไฟฟาและวงจรอิเล็กทรอนิกส และเปนที่

แพรหลาย ในอุปกรณอิเล็กทรอนิกส ตัวตานทานในทางปฏิบัติจะประกอบดวยสารประกอบและ

ฟลมตางๆ เชนเดียวกับ สายไฟตานทาน (สายไฟที่ทําจากโลหะผสมความตานทานสูง เชน นิกเกิล-

โครเมี่ยม) Resistors ยังถูกนําไปใชในวงจรรวม โดยเฉพาะอยางยิ่งในอุปกรณแอนะล็อก และยัง

สามารถรวมเขากับวงจรไฮบริดและวงจรพิมพ ฟงกชันทางไฟฟาของตัวตานทานจะถูกกําหนดโดย

คาความตานทานของมัน ตัวตานทานเชิงพาณิชยทั่วไปถูกผลิตในลําดับที่มากกวาเกาขั้นของขนาด 

เมื่อทําการระบุวาตัวตานทานจะถูกใชในการออกแบบทางอิเล็กทรอนิกส ความแมนยําที่จําเปนของ

ความตานทานอาจตองใหความสนใจในการสรางความอดทนของตัวตานทานตามการใชงานเฉพาะ

ของมัน นอกจากน้ีคาสัมประสิทธิ์อุณหภูมิของความตานทานยังอาจจะมีความกังวลในการใชงาน

บางอยางที่ตองการความแมนยํา ตัวตานทานในทางปฏิบัติยังถูกระบุถึงวามีระดับพลังงานสูงสุดซึ่ง

จะตองเกินกวาการกระจายความรอนของตัวตานทานที่คาดวาจะเกิดขึ้นในวงจรเฉพาะ สิ่งน้ีเปน

ความกังวลหลักในการใชงานกับอิเล็กทรอนิกสกําลัง ตัวตานทานที่มีอัตรากําลังที่สูงกวาก็จะมี

ขนาดที่ใหญกวาและอาจตองใช heat sink ในวงจรไฟฟาแรงดันสูง บางคร้ังก็ตองใหความสนใจกับ

อัตราแรงดันการทํางานสูงสุดของตัวตานทาน ถาไมไดพิจารณาถึงแรงดันไฟฟาในการทํางานขั้น

ตํ่าสุดสําหรับตัวตานทาน ความลมเหลวอาจกอใหเกิดการเผาไหมของตัวตานทาน เมื่อกระแสไหล

ผานตัวมัน 

 ตัวตานทานในทางปฏิบัติมีคาการเหน่ียวนําตออนุกรมและคาการเก็บประจุขนาดเล็กขนาน

อยูกับมัน ขอกําหนดเหลาน้ีจะมีความสําคัญในการใชงานความถ่ีสูง ในตัวขยายสัญญาณเสียง

รบกวนตํ่าหรือพรีแอมป ลักษณะการรบกวนของตัวตานทานอาจเปนประเด็น การเหน่ียวนําที่ไม

ตองการ, เสียงรบกวนมากเกินไปและคาสัมประสิทธิ์อุณหภูมิ เหลาน้ีจะขึ้นอยูกับเทคโนโลยีที่ใช 

ในการผลิตตัวตานทาน ปกติพวกมันจะไมไดถูกระบุไวเปนรายตวของตัวตานทานที่ถูกผลิตโดยใช
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เทคโนโลยีอยางใดอยางหน่ึง ตระกูลของ ตัวตานทานเด่ียวก็มีคุณลักษณะตาม form factor ของมัน 

น่ันคือ ขนาดของอุปกรณและตําแหนงของขา (หรือขั้วไฟฟา) ซึ่งมีความเกี่ยวของในการผลิตจริง

ของวงจรที่นํามันไปใช 

 2.2.1 ชนิดของตัวตานทาน ตัวตานทานที่ผลิตออกมาในปจจุบันมีมากมายหลายชนิด 

ในกรณีที่แบงโดยยึดเอาคาความ ตานทานเปนหลักจะแบงออกไดเปน 3 ชนิดคือ 

  2.2.1.1 ตัวตานทานแบบคาคงที่ (Fixed Resistor) 

   ตัวตานทานแบบคาคงที่ (Fixed Resistor) ตัวตานทานชนิดคาคงที่มีหลาย

ประเภท ในหนังสือเลมน้ีจะขอกลาวประเภทที่มีความนิยม ในการนํามาประกอบใชในวงจร 

ทางดานอิเล็กทรอนิกสโดยทั่วไป ดังน้ี 

  1) ตัวตานทานชนิดคารบอนผสม (Carbon Composition) 

  2) ตัวตานทานแบบฟลมโลหะ ( Metal Film) 

  3) ตัวตานทานแบบฟลมคารบอน ( Carbon Film) 

  4) ตัวตานทานแบบไวรวาวด (Wire Wound) 

  5) ตัวตานทานแบบแผนฟลมหนา ( Thick Film Network) 

  6) ตัวตานทานแบบแผนฟลมบาง ( Thin Film Network) 

  2.2.1.2 ตัวตานทานแบบปรับคาได (Adjustable Resistor) 

  ตัวตานทานแบบปรับคาได โครงสรางของตัวตานทานแบบน้ีมีลักษณะ

คลายกับแบบไวรวาวด แตโดยสวนใหญบริเวณลวดตัวนํา จะไมเคลือบดวยสารเซรามิคและมี

ชองวางทําใหมองเห็นเสนลวดตัวนํา เพื่อทําการลัดเข็มขัดคอมตัวตานทาน โดยจะมีขาปรับให

สัมผัสเขากับจุดใดจุดหน่ึง บนเสนลวดของความตานทาน ตัวตานทานแบบน้ีสวนใหญมีคาความ

ตานทานตํ่า แตอัตราทนกําลังวัตตสูง การปรับคาความตานทานคาใดคาหน่ึง สามารถกระทําได

ในชวงของความตานทานตัวน้ัน ๆ เหมาะกับงาน ที่ตองการเปลี่ยนแปลงความตานทานเสมอ ๆ 

  2.2.1.3 ตัวตานทานแบบเปลี่ยนคาได (Variable Resistor) 

  ตัวตานทานแบบเปลี่ยนคาได ตัวตานทานแบบเปลี่ยนคาได (Variable 

Resistor) โครงสรางภายในทํามาจากคารบอน เซรามิค หรือพลาสติกตัวนํา ใชในงานที่ตองการ

เปลี่ยนคาความตานทานบอย ๆ เชนในเคร่ืองรับวิทยุ, โทรทัศน เพื่อปรับลดหรือเพิ่มเสียง, ปรับลด

หรือเพิ่มแสงในวงจรหร่ีไฟ มีอยูหลายแบบขึ้นอยูกับวัตถุประสงคของการใชงาน เชนโพเทนชิโอ

มิเตอร (Potentiometer) หรือพอต (Pot)สําหรับชนิด ที่มีแกนเลื่อนคาความตานทาน หรือแบบที่มี

แกนหมุนเปลี่ยนคาความตานทานคือโวลลุม (Volume) เพิ่มหรือลดเสียงมีหลายแบบใหเลือกคือ               

1 ชั้น, 2 ชั้น และ 3 ชั้น เปนตน สวนอีกแบบหน่ึงเปนแบบที่ไมมีแกนปรับโดยทั่วไปจะเรียกวา 

โวลลุมเกือกมา หรือทิมพอต (Trimpot) 
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 2.2.2  หนวย 

  โอหม (สัญลักษณ: Ω) เปนหนวย SI ของความตานทานไฟฟา ถูกต้ังชื่อตามจอรจ 

ไซมอนโอหม หน่ึงโอหมเทียบเทากับหน่ึงโวลตตอหน่ึงแอมแปร เน่ืองจากตัวตานทานถูกระบุคา

และถูกผลิตในจํานวนที่เยอะมาก หนวยที่หาไดเปนมิลลิโอหม(1 mΩ = 0.001 Ω), กิโลโอหม 

(1 kΩ = 1,000 Ω) และ เมกโอหม (1 MΩ = 1,000,000 Ω) ยังมีในการใชงานทั่วไป 

  คาตรงขามความตานทานเรียกวาคา conductance ตวยอ G = 1/R และมีหนวยวัด

เปน siemens (หนวย SI) บางคร้ังเรียกวา mho ดังน้ันซีเมนสเปนสวนกลับของโอหม: Ω-1 แมวา

แนวคิดของ conductance มักจะถูกใชในการวิเคราะหวงจร ตัวตานทานในทางปฏิบัติจะถูกระบุไว

เสมอในแงของความตานทาน (โอหม) มากกวาคา conductance 

 

2.3  LCD Display 

 

รูปท่ี 2.3 LCD Display  ที่มา  (https://www.google.com/search?q=display) 

 

 LCD หรือ จอภาพผลึกเหลว (อังกฤษ: liquid crystal display: LCD) เปนอุปกรณจอภาพ

แบบแบน บาง สรางขึ้นจากพิกเซลสี หรือพิกเซลโมโนโครมจํานวนมาก ที่เรียงอยูดานหนาของ

แหลงกําเนิดแสง หรือตัวสะทอนแสง นับเปนจอภาพที่ไดรับความนิยมมากขึ้นในปจจุบัน เพราะใช

กําลังไฟฟานอยมาก ดวยเหตุน้ี จึงเหมาะสําหรับการใชงานที่มีแหลงจายไฟเปนแบตเตอร่ี แตละ

พิกเซลของจอผลึกเหลวน้ันประกอบดวยชั้นโมเลกุลผลึกเหลวที่แขวนลอยอยูระหวางขั้วไฟฟา

โปรงแสงสองขั้ว ที่ทําดวยวัสดุอินเดียมทินออกไซด (Indium tin oxide) และตัวกรอง หรือฟลเตอร

แบบโพลาไรซสองตัว แกนโพลาไรซของฟลเตอรน้ันจะต้ังฉากกัน เมื่อไมมีผลึกเหลวอยูระหวาง

กลาง แสงที่ผานทะลุตัวกรองตัวหน่ึงก็จะถูกกั้นดวยตัวกรองอีกตัวหน่ึง กอนที่มีการจายประจุไฟฟา

เขาไป โมเลกุลผลึกเหลวจะอยูในสภาวะไมเปนระบบ (chaotic state) ประจุบนโมเลกุลเหลาน้ีทําให

โมเลกุลทั้งหลายปรับเรียงตัวตามรองขนาดเล็กจ๋ิวบนขั้วอิเล็กโตรด รองบนขั้วทั้งสองวางต้ังฉากกัน 

ทําใหโมเลกุลเหลาน้ีเรียงตัวในลักษณะโครงสรางแบบเกลียว หรือไขว (ผลึก) แสงที่ผานทะลุตัว

กรองตัวหน่ึง จะถูกหมุนปรับทิศทางเมื่อมันผานทะลุผลึกเหลว ทําใหมันผานทะลุตัวกรอง
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โพลาไรซตัวที่สองได แสงคร่ึงหน่ึงถูกดูดกลืนโดยตัวกรองโพลาไรซตัวแรก แตอีกคร่ึงหน่ึงผาน

ทะลุตัวกรองอีกตัว เมื่อประจุไฟฟาถูกจายไฟยังขั้วไฟฟา โมเลกุลของผลึกเหลวก็ถูกถึงขนานกับ

สนามไฟฟา ทําใหลดการหมุนของแสงที่ผานเขาไป หากผลึกเหลวถูกหมุนปรับทิศทางโดยสมบูรณ 

แสงที่ผานทะลุก็จะถูกปรับโพลาไรซใหต้ังฉากกับตัวกรองตัวที่สอง ทําใหเกิดการปดกั้นแสงโดย

สมบูรณ พิกเซลน้ันก็จะมืด จากการควบคุมการหมุนของผลึกเหลวในแตละพิกเซล ทําใหแสงผาน

ทะลุไดในปริมาณตางๆ กัน ทําใหพิกเซลมีความสวางแตกตางกันไป โดยปกติการปรับฟลเตอร

โพลาไรซเพื่อพิกเซลโปรงแสง เมื่อพักตัว และทึบแสงเมื่ออยูในสนามไฟฟา อยางไรก็ตาม บางคร้ัง

ก็เกิดผลตรงกันขาม สําหรับเอฟเฟกตแบบพิเศษ 

 2.3.1 ชนิดของจอภาพ 

  2.3.1.1  TN+Film (Twisted Nematic) เปนเทคโนโลยีของจอผลึกเหลว ที่นิยมใช

อยางแพรหลาย เน่ืองจากมีตนทุนการผลิตที่ตํ่า และการพัฒนาอยางตอเน่ือง ซึ่งในปจจุบัน พัฒนา

จนสามารถทําใหมีความเร็วของการตอบสนองดวยความเร็วสูงเพียงพอที่จะทําให เงาบน

ภาพเคลื่อนไหวลดลงไดมาก ทําใหจอแบบ TN+Film มีจุดเดนดานการตอบสนองไดอยางรวดเร็ว 

(จอTN+Film จะใชการวัดการตอบสนอง เปนแบบ grey to grey ซึ่งจะแตกตางจากคา ISO ที่วัดแบบ 

black to white) แตจุดเสียของจอแบบ TN+Film น่ันคือมีรัศมีการมองเห็นที่แคบ โดยเฉพาะแนวต้ัง 

และสวนใหญจะไมสามารถแสดงสีไดครบ 16.7ลานสี (24-bit truecolor) 

  2.3.1.2  IPS (In-Plane Switching) คิดคนโดยบริษัท Hitachi ในป พ.ศ. 2539 ซึ่งมี

คุณสมบัติเดนกวา TN+Film ทั้งดานรัศมีการมองเห็น และการแสดงสีที่ 8-bit แตการปรับปรุง

ดังกลาว ทําใหเกิดการตอบสนองที่ชักชา ถึง 50ms และยังแพงมากอีกดวย จากน้ันในป พ.ศ. 2541 

Hitachi ไดนําระบบ S-IPS (Super-IPS) ออกมาแทนที่ระบบ IPS เดิม ซึ่งไดมีการปรับปรุง

ประสิทธิภาพในดานการตอบสนองที่ดีขึ้น และสีสันที่ใกลเคียงจอภาพแบบ CRT พบไดใน

โทรทัศนระบบจอผลึกเหลว 

  2.3.1.3  MVA เปนการรวมขอดีระหวาง TN+Film กับ IPS เขาดวยกันทําใหมี 

Response Time ที่ตํ่า และ View Angle ที่กวางเปนพิเศษ แตมีราคาแพงมาก 

  2.3.1.4  PVA เปนการพัฒนาจากแบบ MVA ใหมีราคาถูกลงซึ่งทําใหมีคา Contrast 

Ratio ที่สูงมาก และมี Response Time ที่ตํ่า ใชในจอภาพแบบผลึกเหลวระดับสูง 
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2.4  บอรด Arduino 

 

รูปท่ี 2.4 บอรด Arduino  ที่มา  (https://www.google.com/search?q=Arduino) 

 

 เปนบอรดไมโครคอนโทรเลอรตระกูล AVR ที่มีการพัฒนาแบบ Open Source คือมีการ

เปดเผยขอมูลทั้งดาน Hardware และ Software ตัว บอรด Arduino ถูกออกแบบมาใหใชงานไดงาย 

ดังน้ันจึงเหมาะสําหรับผูเร่ิมตนศึกษา ทั้งน้ีผูใชงานยังสามารถดัดแปลง เพิ่มเติม พัฒนาตอยอดทั้งตัว

บอรด หรือโปรแกรมตอไดอีกดวย ความงายของบอรด Arduino ในการตออุปกรณเสริมตางๆ คือ

ผูใชงานสามารถตอวงจรอิเล็กทรอนิกสจากภายนอกแลวเชื่อมตอเขามาที่ขา I/O ของบอรด (ดู

ตัวอยางรูปที่ 1) หรือเพื่อความสะดวกสามารถเลือกตอกับบอรดเสริม (Arduino Shield) ประเภท

ตางๆ (ดูตัวอยางรูปที่ 2) เชน Arduino XBee Shield, Arduino Music Shield, Arduino Relay Shield, 

Arduino Wireless Shield, Arduino GPRS Shield เปนตน มาเสียบกับบอรดบนบอรด Arduino แลว

เขียนโปรแกรมพัฒนาตอไดเลย 

  

https://www.google.com/search?q=Arduino
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2.5  ลําโพงบัซเซอร (Buzzer) 

 

รูปท่ี 2.5  ลําโพงบัซเซอร (Buzzer)  ที่มา  (https://www.google.com/search?q=buzzer) 

 

 ลําโพงบัซเซอรเปนอุปกรณที่ใหกําเนิดเสียงทําหนาที่เปลี่ยนสัญญาณไฟฟาใหอยูในรูป

สัญญาณเสียง ลําโพงบัซเซอรมีอยู 2 ประเภท ไดแก 

  2.5.1  แบบแอคทีฟ (Active Buzzer) ลําโพงชนิดน้ีมีวงจรกําเนิดความถ่ีอยูภายใน 

สามารถสราง สัญญาณเสียงเตือนไดทันทีเพียงแคจายแรงดันไฟฟาเขาไป 

  2.5.2  แบบพาสซีฟ (Passive Buzzer) ลําโพงชนิดน้ีทํางานเหมือนลําโพงขนาดเล็ก 

คือ ถาปอน แรงดันไฟฟากระแสตรงเขาไปไมมีเสียงถาตองการใหมีสัญญาณเสียงตองทําการปอน

สัญญาณความถ่ี เขาไป ลําโพงชนิดน้ีสามารถกําเนิดเสียงที่มีความแตกตางกันตามความถ่ีที่ปอนเขา

มา 

 ในหนวยน้ีเปนการใชงาน Arduino กับลําโพงบัซเซอรแบบพาสซีฟ ดังน้ันการใชงานตอง

ทําการ เขียนโปรแกรมเพื่อสงความถ่ีจาก Arduino เขาไปยังลําโพงบัซเซอร ปจจุบันเคร่ืองใชไฟฟา

โดยทั่วไปมีลําโพงบัซเซอรติดต้ังอยูภายในดวย เชน ในคอมพิวเตอรใชลําโพงบัซเซอรเพื่อสง

สัญญาณใหทราบวาสถานะของคอมพิวเตอรมีปญหาอะไร หรือในเคร่ืองซักผาอัตโนมัติ 

เคร่ืองปรับอากาศ เมื่อทําการกดปุมบนเคร่ืองหรือรีโมตคอนโทรลจะไดยินเสียงปนดังขึ้นมาดวย

เพื่อบอกใหรูวาขณะน้ีทําการกด สวิตชแลว 

 

 

https://www.google.com/search?q=buzzer


14 
 

2.6  หลอดไฟ LED สีเขียว สีแดง 

 

รูปท่ี 2.6  หลอดไฟ LED สีเขียว สีแดง  ที่มา  (https://www.google.com/search?q=LED) 

 

 คําวา LED ยอมาจาก Light Emitting Diode หรือเรียกวา ไดโอดเปลงแสง เปนอุปกรณสาร

กึ่งตัวนําอยางหน่ึง จัดอยูในรูปของไดโอด ที่ยอมใหกระแสไฟฟาไหลผานแลวเปลงแสงสวาง เปน

แสงชวงอัลตราไวโอเลตและชวงอินฟราเรด ซึ่งเปนชวงแสงที่สามารถมองเห็นได ผูพัฒนาคนแรก 

คือ “นิก โฮโลยักษ”  

 color (wavelength) เปนตัวบอกสี ซึ่งหมายถึงขนาดของความยาวคลื่นที่ LED เปลงแสง

ออกมา 

 สีฟา จะมีความยาวคลื่น ประมาณ 468nm 

 สีขาว จะมีความยาวคลื่น ประมาณ 462nm 

 สีเหลือง จะมีความยาวคลื่น ประมาณ 468nm 

 สีเขียว จะมีความยาวคลื่น ประมาณ 565nm 

 สีแดง จะมีความยาวคลื่น ประมาณ 630nm เปนตน 
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2.7  สายไฟ ชนิด Male to Male 

 

รูปท่ี 2.7  สายไฟ ชนิด Male to Male  ที่มา  (https://www.google.com/search?q=Male to Male) 

 

 ในคอมพิวเตอร Jumper เปนคูของขา (prong) ใชในการตอเชื่อมจุด ในแผนเมนบอรดหรือ 

อะแดปเตอรการด การเซ็ท Jumper เปนการวางปลั๊กบนขา ก็ทําใหการตอเชื่อมเสร็จสมบูรณ ซึ่ง 

การเซ็ท Jumper เปนการบอกกับเคร่ืองคอมพิวเตอรใหทราบถึง การคอนฟกและการทํางานที่

ตองการ ในบางคร้ังคําสั่งสามารถปรับการต้ัง Jumper โดยตัวเอง เมื่อมีการเพิ่มอุปกรณใหม 

แนวโนมลาสุดอุปกรณแบบ plug and play ไมจําเปนตองใชการเซ็ท Jumper แบบ Manual กลุม

ของ Jumper ในบางคร้ังเรียกวา Jumper block 

 การต้ังคา Jumper ที่ถูกตองตามลักษณะคอนฟกของคอมพิวเตอร จําเปนตองมีขอมูลทาง

เทคนิคที่มาพรอมกับสินคาสําหรับการเซ็ท Jumper 

 

2.8  สายไฟ ชนิด Male to Female 

 

รูปท่ี 2.8  สายไฟ ชนิด Male to Female  ที่มา  (https://www.google.com/search?q=Male) 
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2.6  การใชงานโปรแกรม Arduino IDE 

 2.6.1  เปดโปรแกรม Arduino IDE ขึ้นมา 

 

รูปท่ี 2.6 เปดโปรแกรม Arduino IDE  ที่มา  (https://www.google.com/search?q=ArduinoIDE) 

 

 2.6.2  สราง Sketch ใหม โดยคลิกที่เมนู File > New 

 

รูปท่ี 2.7 สราง Sketch ใหม โดยคลิกที่เมนู File > New  ที่มา  (https://www.google.com/search?) 

https://www.google.com/search?q=Arduino
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 2.6.3  เขียนโปรแกรมลงไปตรงพื้นที่สีขาว ซึ่งการเขียนโปรแกรมสําหรับ Arduino 

จะประกอบไปดวยฟงกชั่น setup และ ฟงกชั่น loop ซึ่งมีความหมายดังน้ี 

 

รูปท่ี 2.8 เขียนโปรแกรมลงไปตรงพื้นที่  ที่มา  (https://www.google.com/search?q=program) 

 

 2.6.3.1  ฟงกชั่น setup จะเร่ิมทํางานเปนอันดับแรกเมื่อ Arduino เร่ิมทํางาน                  

และคําสั่งที่ถูกเขียนลงไปในน้ี จะทํางานเพียงคร้ังเดียวเทาน้ัน 

 2.6.3.2  ฟงกชั่น loop จะเร่ิมทํางานทันทีเมื่อฟงกชั่น setup ทํางานเสร็จ และคําสั่ง

ที่ถูกเขียนลงไปในน้ี จะทํางานต้ังแตคําสั่งแรก ไลไปจนถึงคําสั่งสุดทาย แลวกลับมาที่คําสั่งแรก ไล

ไปจนถึงคําสั่งสุดทาย วนซ้ําแบบน้ีไปเร่ือยๆ ตลอดการทํางานของ Arduino 

 2.6.4  เมื่อเขียนโปรแกรมเสร็จแลวใหบันทึกเก็บไวโดยคลิกที่เมนู File > Save จากน้ันจะมี

หนาตางขึ้นมาใหเราเลือกวาจะบันทึกไวที่ไหน และต้ังชื่อ Sketch  

  

https://poundxi.com/wp-content/uploads/2018/07/Arduino-IDE-Code-Editor-2.png
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รูปท่ี 2.9 เมื่อเขียนโปรแกรมเสร็จแลวใหบันทึกเก็บไวโดยคลิกที่เมนู File > Save  ที่มา  

(https://www.google.com/search?q=Filesave) 

 

รูปท่ี 2.10 ตําแหนงที่เลือกบันทึกและต้ังชื่อไฟล  ที่มา  (https://www.google.com/search?q= 

Blink) 

  

https://www.google.com/search?q
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เมื่อทําถูกตองที่ Tittle bar จะแสดงชื่อ Sketch ตามที่ไดต้ังชื่อไว 

 

รูปท่ี 2.11 Tittle bar จะแสดงชื่อ Sketch ตามที่ไดต้ังชื่อไว  ที่มา  (https://www.google.com/0Search? 

=tittlebar) 

 

 2.6.5  ตอบอรด Arduino เขากับคอมพิวเตอรผานสาย USB  

 2.6.6  ต้ังคาเพื่อบอก Arduino IDE วาเราจะอัพโหลดโปรแกรมใหกับบอรดรุนอะไร และ

อัพโหลดผาน Port ไหน 

 

 

  2.6.6.1  คลิกที่เมนู Tools > Board เลือกบอรด Arduino ใหตรงกับรุนที่เราตอใช

งานอยู 

รูปท่ี 2.12 คลิกที่เมนู Tools > Board เลือกบอรด Arduino  ที่มา 

(https://www.google.com/0Search?=toolsboard) 

 

https://www.google.com/
https://www.google.com/
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  2.6.6.2  คลิกที่เมนู Tools > Port  ติดต้ัง Driver ไวแลว และบอรดไมไดเสีย จะมี

รายการขึ้นมาใหเลือกแครายการเดียว 

 

รูปท่ี 2.13 คลิกที่เมนู Tools > Port  ที่มา  (https://www.google.com/0Search?q=toolsport) 

 

 2.6.7  คลิกปุมอัพโหลด หรือจะคลิกที่เมนู Sketch > Upload 

 

รูปท่ี 2.14 คลิกปุมอัพโหลด หรือจะคลิกที่เมนู Sketch > Upload  ที่มา  (https://www.google.com/0 

Search?q=sketchupload) 

  

https://www.google.com/
https://www.google.com/
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 หากเขียนโปรแกรมถูกตอง และไมไดมีปญหาระหวางการอัพโหลด จะมีขอความขึ้นวา

Done uploading และจะมีขอความรายงานเปนขอความสีขาวๆ 

 

รูปท่ี 2.15 Done uploading  ที่มา  (https://www.google.com/0Search?q=doneupload) 

 

หากเขียนโปรแกรมผิดจะแสดงเปนขอความสีสมๆ ที่เมื่อแปลขอความแลวก็พอจะสามารถเดาไดวา

เราเขียนโปรแกรมผิดตรงจุดไหน เชน “expected ‘;’ before ‘}’ token” แปลวา ลืมพิมพ ; กอน

เคร่ืองหมายปกกา } เปนตน 

https://www.google.com/
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รูปท่ี 2.16 หากเขียนโปรแกรมผิดจะแสดงเปนขอความ  ที่มา  (https://www.google.com/0 

Search?q=token) 

 

หรือหากมีปญหาระหวางการอัพโหลด ก็จะมีขอความขึ้นวา Problem uploading to board.

ซึ่ ง ป ญ ห า อ า จ เ กิ ด ข้ึ น ไ ด จ า ก ห ล า ย ป จ จั ย  แ น ะ นํ า ใ ห เ ข า ไ ป ศึ ก ษ า วิ ธี แ ก ป ญ ห า ไ ด ที่

เว็บไซต https://www.arduino.cc/en/Guide/Troubleshooting#upload 

 

รูปท่ี 2.17 ปญหาระหวางการอัพโหลดขอความขึ้นวา Problem uploading to board  ที่มา  

(https://www.google.com/0Search?q=problemuploadtoboard) 

 

 

 

https://www.google.com/
https://www.arduino.cc/en/Guide/Troubleshooting#upload
https://www.google.com/
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2.7  หลักการเขียนโปรแกรม Arduino 

 ภาษาซีของ Arduino จะจัดรูปแบบโครงสรางของการเขียนโปรแกรมออกเปนสวนยอยๆ

หลายๆสวน โดยเรียกแตละสวนวา ฟงกชั่น และ เมื่อนําฟงกชั่น มารวมเขาดวยกัน ก็จะเรียกวา

โปรแกรม โดยโครงสรางการเขียนโปรแกรมของ Arduino น้ัน ทุกๆโปรแกรมจะตองประกอบไป

ดวยฟงกชั่นจํานวนเทาใดก็ได แตอยางนอยที่สุดตองมีฟงกชั่น จํานวน 2 ฟงกชั่น คือ setup() และ 

loop() 

 2.7.1  โครงสรางการเขียนโปรแกรม Arduino 

 

  #include<servo.h>                 //เรียกไลบราร่ี ชื่อ servo.h เขามาใชในโปรแกรม 

  int Servo1=9;                         //กําหนดให Servo1 แทน Pin Digital-9 

  Servo myservo;                      //สราง object ชื่อ myservo เพื่อควบคุม Servo 

  void setup() 

  { 

  myservo.attach(Serrvo1);       //กําหนดใหใชขา Digital-9 สรางสัญญาณควบคุม 

  Servo 

  } 

  void loop() 

  { 

  myservo.write(180);               //กําหนดคาตําแหนงใหกับ Servo = 180 องศา 

  } 

 

  จะไดโครงสรางพื้นฐานของภาษาซีที่ใชกับ Arduino น้ันจะประกอบไปดวย 3 

สวนใหญๆดวยกัน คือ 

  2.7.1.1  Header ในสวนน้ีจะมีหรือไมมีก็ได ถามีตองกําหนดไวในสวนเร่ิมตนของ

โปรแกรม ซึ่งสวนของ Header ไดแก สวนที่เปน Compiler Directive ตางๆรวมไปถึงสวนของการ

ประกาศตัวแปร และคาคงที่ตางๆที่จะใชในโปรแกรม 

 

  2.7.1.2  setup() ในสวนน้ีเปนฟงกชั่นบังคับที่ตองกําหนดใหมีในทุกๆโปรแกรม 

ถึงแมวาในบางโปรแกรมจะไมตองการใชงานก็ยังจําเปนตองประกาศไวดวยเสมอ เพียงแตไมตอง

เขียนคําสั่งใดๆไวในระหวางวงเล็บปกกา {} ที่ใชเปนตัวกําหนดของเขตของฟงกชั่น โดยฟงกชั่นน้ี
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จะใชสําหรับบรรจุคําสั่งในสวนที่ตองกาใหโปรแกรมทํางานเพียงรอบเดียวตอนเร่ิมตนทํางานของ

โปรแกรมคร้ังแรกเทาน้ัน ซึ่งไดแกคําสั่งเกี่ยวกับการ Setup คาการทํางานตางๆ เชน การกําหนด

หนาที่การใชงานของ PinMode และการกําหนดคา Baudrate สําหรับใชงานพอรตสื่อสารอนุกรม 

เปนตน 

  2.7.1.3  loop() เปนสวนฟงกชั่นบังคับที่ตองกําหนดใหมีในทุกๆโปรแกรม

เชนเดียวกันกับฟงกชั่น setup() โดยฟงกชั่น loop() น้ีจะใชบรรจุคําสั่งที่ตองการใหโปรแกรมทํางาน

ซ้ําๆกันไปไมรูจบ ซึ่งถาเปรียบเทียบกับรูปแบบของ ANSI-C สวนน้ีก็คือ ฟงกชั่น main() น่ันเอง 

 

 2.7.2  คําสั่งในการเขียนโปรแกรม Arduino 

  #include <header.h> 

  เมื่อพบคําสั่ง #include ตัวแปลภาษาของ Arduino จะไปคนหาไฟลที่ระบุไวใน

เคร่ืองหมาย <> หลังคําสั่ง #include จากตําแหนง Directory ที่เก็บไฟล Library ของโปรแกรม 

Arduino ไว ซึ่งแนนอนวาสวนของ Header จะนับรวมไปถึง คําสั่งสวนที่ใชประกาศสราง ตัวแปร

(Variable Declaration)และคาคงที่(Constant Declaration) รวมทั้ง ฟงกชั่นตางๆ (Function 

Declaration) ดวย ซึ่งจากตัวอยางไดแกสวนที่เปนคําสั่ง 

 

  int Servo1=9; 

  Servo myservo 

  สําหรับสวนที่สําคัญที่สุดและขาดไมได คือ ฟงกชั่น setup() และ ฟงกชั่น loop() 

ซึ่งฟงกชั่น ทั้ง 2 สวนน้ีมีรูปแบบโครงสรางที่เหมือนกัน แตถูกกําหนดดวยชื่อฟงกชนเปนการ

เฉพาะ คือ setup() และ loop() โดย setup() จะเขียนไวกอน loop() ซึ่งทัง 2 ฟงกชั่นน้ี มีขอบเขต 

เร่ิมตนและสิ้นสุด อยูภายใตเคร่ืองหมาย{} 

 

  void setup() 

  { 

  คําสั่งตางๆ ที่ตองการเขียนไวภายใตฟงกชั่น setup() 

  } 
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 หนาที่ของฟงกชั่น setup() ใน Arduino คือ ใชทําหนาที่เปนสวนของโปรแกรมยอยสําหรับ

ใชบรรจุคําสั่งตางๆที่ใชสําหรับกําหนดกาทํางานของระบบ หรือ กําหนดคุณสมบัติการทํางาน

ใหกับอุปกรณตางๆซึ่งคําสั่งทั้งหมดที่บรรจุไวภายใตฟงกชั่นของ Setup() น้ี จะถูกเรียกขึ้นมาทํางาน

เพียงรอบเดียวคือตอนเร่ิมตนการทํางานของโปรแกรม โดยคําสั่งที่นิยมบรรจุไวในฟงกชั่นสวนน้ี 

ไดแก คําสั่งสําหรับกําหนดโหมดการทํางานของ Digital Pin หรือ คําสั่งสําหรับ กําหนดคุณสมบัติ

ของพอรตสื่อสารอนุกรม เปนตน 

 

  void loop() 

  { 

  คําสั่งตางๆที่ตองการใหทํางานภายใตฟงกชั่น loop() 

  } 

 

 หนาที่ของฟงกชั่น loop() ใน Arduino คือใชทําหนาที่เปนสวนของโปรแกรมหลัก สําหรับ

ใชบรรจุ คํ าสั่ งควบ คุมการทํ า งานต าง ๆของโปรแกรม ที่ ตองการใ ชโปรแก รมทํ างา น                    

โดยคําสั่งที่บรรจุไวในฟงกชั่นน้ีจะถูกเรียกขึ้นมาทํางานซ้ําๆกันตามลําดับและเงื่อนไขที่กําหนดไว 

 

2.11  ความรูเบื้องตนเกี่ยวกับกาซปโตรเลียมเหลว LPG 

 กาซปโตรเลียมเหลว หรือ LPG ยอมาจาก Liquefied Petroleum Gas  ไดมาจากแหลงใหญ 

3 แหลง คือ  จากการแยกกาซธรรมชาติ  ไดมาจากกระบวนการกลั่นนํ้ามันดิบในโรงกลั่นนํ้ามัน  

และไดมาจากการนําเขาโดยตรง โดยกาซปโตรเลียมเหลว LPG สามารถอยูไดทั้งในสถานะ

ของเหลวและกาซ  ซึ่ง LPG ในทองตลาดสวนใหญจะประกอบดวยสารประกอบไฮโดรคารบอน 2 

ชนิด คือ โพรเพน(Propane) และ บิวเทน(Butane)  โดยคุณสมบัติหลักๆของ กาซ LPG มีดังน้ี 

 1. LPG มีจุดเดือดตํ่ามาก โดย Propane มีจุดเดือด -42�C และ Normal Butane มีจุดเดือด -

0.5�C LPG มีสถานะเปนกาซที่อุณหภูมิปกติ และความดันบรรยากาศ เวนเสียแตจะถูกอัดใหเปน

ของเหลวอยูในถังภายใตความดันหรือนําถังไปแชเย็นเอาไว เมื่อ LPG ระเหยออกสูบรรยากาศก็จะ

เดือดทันที การเปลี่ยนสถานะกระทันหันทําใหเกิดการดูดความรอนในบริเวณน้ัน ทําใหมองเห็น

เปนไอสีขาว มีหยดนํ้าหรือเกิดนํ้าแข็งเกาะ โดยเมื่อ LPG เปลี่ยนจากของเหลวกลายเปนไอจะ

ขยายตัวถึง 250 เทา และจะกลายเปน 14000 เทาเมื่อผสมกับอากาศ ดังน้ันในการบรรจุกาซ LPG จึง

นิยมบรรจุไมเต็มเพื่อรองรับการขยายตัวของกาซ 

 2. ความดันไอ Propane มีความดันไอ 113 psi at 20�C และ Butane มีความดันไอที่ 30 

psi at 20�C โดนแรงดันของ LPG จะขึ้นอยูกับสวนผสมของ propane และ butane รวมถึง
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อุณหภูมิดวย โดยปกติ LPG จะมีแรงดันขณะใชงาน 100 psi ซึ่งการออกแบบภาชนะจัดเก็บ LPG 

จะตองออกแบบใหสามารถรับแรงดันได 250 psi 

 3. คาการติดไฟ LPG มีคาในการติดไฟอยูที่ LEL 2.0% – UEL 9.5% ถามีกาซ LPG ตํ่ากวา 

2 สวนหรือมากกวา 9 สวนในสวนผสมของกาซกับอากาศกับอากาศ 100 สวน สวนผสมน้ันก็จะไม

ติดไฟ 

 4. อุณหภูมิของจุดติดไฟ (Ignition Temperature) เน่ืองจากอุณหภูมิจุดติดไฟของ Propane 

คือ 460-580 องศาเซลเซียส และของ Butane คือ 410-550 องศาเซลเซียส ดังน้ัน กาซปโตรเลียม

เหลวจึงติดไฟไดยากกวาเมื่อเทียบกับนํ้ามันเบนซินซึ่งมีจุดติดไฟ 280 – 430 องศาเซลเซียสและ

นํ้ามันดีเชล 250 – 340 องศาเซลเซียส ดังน้ันกาซปโตรเลียมเหลวมีความปลอดภัยสูงกวาในประเด็น

การจุดติดไฟไดเอง 

 5. ความถวงจําเพาะและความหนาแนนของไอ LPG มีคาความถวงจําเพาะ(Liquid Specific 

Gravity) ประมาณ 0.5-0.6 ซึ่งเบากวานํ้า ทําใหกรณีถาเกิดการร่ัวไหลของ LPG ลงทอนรับนํ้า ทาง

ระบายนํ้า หรือแหลงนํ้าจะทําให LPG ลอยอยูบนผิวนํ้าและไหลไปตามกระแสนํ้าได ถาเกิดประกาย

ไฟและความเขมขนอยูในชวงติดไฟก็จะสามารถเกิดไฟไหมบนผิวนํ้าไดในที่หางไกลจากแหลง

ร่ัวไหล   นอกจากน้ี LPG ยังมีคาความหนาแนนของไอ(Vapor Specific Gravity) ประมาณ 1.52-2.0 

คือหนักกวาอากาศ จะทําใหกรณีเกิดการร่ัวไหลแลว LPG จะนอนอยูที่พื้นเน่ืองจากหนักกวาอากาศ

น่ันเอง 

 6. อุณหภูมิเปลวไฟ LPG เมื่อติดไฟแลวใหอุณหภูมิสูงประมาณ 1900-2000 �C ดังน้ันจึง

เหมาะสําหรับงานอุตสาหกรรมหลอมโลหะ สามารถนําไปใชในการอบเคร่ืองเคลือบดินเผาอบสี 

ไดอยางมีประสิทธิภาพ 

 7. คาความรอนและการเผาไหม อยูประมาณ 10000-12000 kcal/kg 

 8. คาออกเทน (Octane Number)กาซแอลพีจีมีคาออกเทนสูง ประมาณ 95-110 ซึ่งสูงกวา

คาออกเทนของนํ้ามันเบนซิน จึงเหมาะกับการใชเปนเชื้อเพลิงของรถยนตมาก 

 9. คุณสมบัติทางกายภาพ ไมมีสี ไมมีกลิ่น แตจะมีการเติมเอธิลเมอรแคปแทน C2H5SH 

เพื่อใหผูใชงานทราบวาเกิดการร่ัวของกาซ 

 10. LPG มีคุณสมบัติเปนตัวทําละลาย (solvent) เชนเดียวกับพวกนํ้ามันระเหย จึงสามารถ

ละลายหรือทําใหอุปกรณตาง ๆ ที่ทํามาจากยางธรรมชาติเสียคุณสมบัติได เชน ปะเก็น หรือซีลตาง 

ๆ ดังน้ันอุปกรณที่นํามาใชกับถังที่บรรจุกาซแอลพีจี ควรใชวัสดุอ่ืนที่ไมไดทํามาจากยางธรรมชาติ 

เชน ยางสังเคราะห เปนตน 

 ถึงแมวา กาซปโตรเลียมเหลว (LPG) จะไมมีคุณสมบัติเปนพิษทางเคมี แตเมื่อกาซร่ัว

ออกมาแทนที่อากาศก็สามารถทําใหเกิดการขาดออกซิเจน หมดสติ และตายเน่ืองจากการขาด
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อากาศหายใจได  นอกจากน้ีตองระมัดระวังไมใหสัมผัสกับของเหลว หรือที่เรียกวานํ้ากาซโดยตรง

เน่ืองจากนํ้ากาซจะดูดความรอนออกจากรางกาย ซึ่งจะทําใหรางกายเกิดการเผาไหมแบบเย็น หรือ 

Cold burn 

 มาตรฐานอาชีวอนามัยและความปลอดภัย สําหรับผูใชแรงงานที่ตองคลุกคลีและเกี่ยวของ

กับ LPG กระทรวงแรงงานสหรัฐอเมริกาไดกําหนดมาตรฐานอาชีวอนามัยและความปลอดภัยไววา 

“ในอากาศ สถานที่ที่ทํางานจะมี LPG ไดไมเกิน 1,000 สวนตออากาศลานสวน (ppm) โดยเฉลี่ยใน

ระยะเวลาการทํางาน 8 ชั่วโมงหรือ 1,800 มิลลิกรัมของ LPG ตอหน่ึงลูกบาศกเมตรของอากาศ” 



 

 

บทที่  3 

วิธีการดําเนินโครงการ 
 

 ในการดําเนินโครงการสรางเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล (Gas leak detector 

and alarm) มีข้ันตอนการสรางในสวนตาง ๆ โดยทางกลุมผูสรางไดรวมกันวางแผนในการ

ปฏิบัติงาน และจัดแบงงานตามความเหมาะสม 

        ขั้นตอนในการดําเนินโครงการ  แบงออกเปนดังน้ี 

      3.1  การวางแผนและการเตรียมงาน 

      3.2  การออกแบบ 

      3.3  การดําเนินการสราง 

 

3.1  การวางแผนและการเตรียมการ 

      การวางแผนและการเตรียมการ  เร่ิมเมื่อคณะกรรมการพิจารณาโครงการในเสนอหัวขอ

โครงการในภาคเรียนที่ 1 ทางกลุมผูจัดทําไดนําเสนอหัวขอโครงการเคร่ืองตรวจจับและแจงเตือน

แกสร่ัวไหล ซึ่งมีลําดับขั้นตอนตาง ๆ ในการดําเนินการดังตารางที่  3.1 

       3.1.1  การวางแผนการทําโครงการ 

 3.1.1.1  เสนอหัวขอโครงการกับอาจารยคุณานนท  สุขเกษม 

 3.1.1.2  หาขอมูลเพิ่มเติม  เร่ืองความเปนมาของเคร่ืองตรวจจับแกส 

 3.1.1.3  อนุมัติโครงการ  โดยอาจารยคุณานนท สุขเกษม 

 3.1.1.4  เขียนโครงการบทที่ 1-2 

 3.1.1.5  ศึกษาแบบและขอมูล  โดยศึกษาตามเว็บไซตตาง ๆ เปนตน 

 3.1.1.6  ออกแบบและจัดทําโครงสรางเคร่ืองตรวจจับแกส 

 3.1.1.7  วางแผนการปฏิบัติงาน  โดยจัดลําดับกอนและหลังการปฏิบัติงาน 

 3.1.1.8  สงโครงการบทที่ 1-2 ใหอาจารยคุณานนท  สุขเกษม 

 3.1.1.9  ศึกษาโปรแกรม Arduino IDE   

 3.1.1.10  ศึกษาอุปกรณในการสรางเคร่ืองตรวจจับแกส 

 3.1.1.11  ดําเนินการสรางเคร่ืองตรวจจับแกส 

 3.1.1.12  เขียนคําสั่งการทํางานผานโปรแกรม Arduino IDE   

 3.1.1.13  ทําการทดสอบเคร่ืองตรวจจับแกส 

 3.1.1.14  แกไขจุดบกพรองของเคร่ืองตรวจจับใหสมบูรณ 

 3.1.1.15  ตกแตงเคร่ืองจับใหเหมาะสมกับการติดต้ังและใชงาน 

 3.1.1.16  ทดลองใชงานจริง 



 

 

 3.1.1.17  เขียนโครงการบทที่ 3-5 โดยนําขอมูลที่ไดจากการสรางเคร่ืองตรวจจับและ 

แจงเตือนแกสร่ัวไหล, ผลการทดลองเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล, การนําปญหาที่

ประสบในการดําเนินโครงการและขอเสนอแนะตาง ๆ มาเรียงใหไดใจความที่สมบูรณ 

 3.1.1.18  สงโครงการบทที่ 1-5 โดยใหอาจารยคุณานนท  สุขเกษม เปนผูตรวจสอบ 

ความถูกตอง 

 3.1.1.19  ยื่นขอสอบโครงการ หลังจากทฤษฎีบทที่ 1-5 ไดผานการตรวจสอบความ

ถูกตองแลว 

 3.1.1.20  อนุมัติสอบโครงการ 

 3 .1 .1 .21  สอบโครงการ เปนการนํา เสนอเน้ือหาตาง  ๆ ในบทที่  1 -5 กับ

คณะกรรมการสอบโครงการ ใหทราบขอมูลตาง ๆ ที่เกี่ยวของกับการทําโครงการน้ี 

 3 .1 .1 .22 สงโครงการ โดยนํา เ น้ือหาบทที่  1 -5  มา เข า เลม   แลว นําไปให                                       

กับคณะกรรมการสอบโครงการไวเปนตัวอยางในการศึกษาและเปนหลักฐาน 

 

 3.1.2  การเตรียมการ 

  3.1.2.1  ศึกษาภาษาโปรแกรม Arduino IDE   

 3.1.2.2  กําหนดคุณภาพคุณสมบัติของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 3.1.2.3  กําหนดขอบเขตของการทํางานของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 3.1.2.4  กําหนดประโยชนของเคร่ืองตรวจจับแกสที่คาดวาจะไดรับ 

 3.1.2.5  กําหนดคาใชจายของการทําโครงการ 

 3.1.2.6  กําหนดขั้นตอนการดําเนินการ 

 3.1.2.7  วางรูปแบบและองคประกอบของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 3.1.2.8  กําหนดโครงสรางการทํางานของเคร่ืองตรวจจับแกส 

 3.1.2.9  คนหาขอมูลจากเว็บตาง ๆ 

 



 

 

ตารางการวางแผนงานและการเตรียมการโครงการน้ีใชระยะเวลาในการพัฒนาต้ังแตเดือน

มิถุนายน  พ.ศ. 2562 ถึงเดือน กุมภาพันธ พ.ศ. 2563 

 

ตารางท่ี 3.1  แสดงแผนการดําเนินโครงการ 

ลําดับการทํางาน 

เดือนที่ 

มิ.ย. 

62 

ก.ค. 

62 

ส.ค. 

62 

ก.ย. 

62 

ต.ค. 

62 

พ.ย. 

62 

ธ.ค. 

62 

ม.ค. 

63 

ก.พ. 

63 

1.  เสนอหัวขอโครงการ *         

2.  หาขอมูลเพิ่มเติม *         

3.  อนุมัติโครงการ  *        

5.  ศึกษาคนควาขอมูล  *        

6.  ออกแบบ ทําโครงสราง

เคร่ืองตรวจจับแกสร่ัวไหล 

 
*        

7.  วางแผนการปฏิบัติงาน     *       

8.  สงโครงการบทที่ 1-2    *      

9.  ศึกษาโปรแกรม 

Arduino IDE   

  
 *      

10.  ศึกษาอุปกรณในการ

สรางเคร่ืองตรวจจับแกส 

  
 *      

11.  ดําเนินการสรางเคร่ือง

ตรวจจับแกส 

  
 *      

12.  เขียนคําสั่งการทํางาน

ผานโปรแกรม Arduino 

IDE   

  

 *      

13  ทําการทดสอบเคร่ือง

ตรวจจับแกส 

  
       

14.  แกไขจุดบกพรองของ

เคร่ืองตรวจจับใหสมบูรณ 

  
 *      

15.  ตกแตงเคร่ืองจับให

เหมาะสมกับการติดต้ังและ

ใชงาน 

  

 *      



 

 

ตารางท่ี 3.1 แสดงผลการดําเนินโครงการ (ตอ) 

ลําดับการทํางาน 

เดือนที่ 

มิ.ย. 

62 

ก.ค. 

62 

ส.ค. 

62 

ก.ย. 

62 

ต.ค. 

62 

พ.ย. 

62 

ธ.ค. 

62 

ม.ค. 

63 

ก.พ. 

63 

16.  ทดลองใชงานจริง    *      

17.  เขียนโครงการบทที่ 3-

5 

  
 *      

18.  สงโครงการบทที่ 1-5      *    

19.  ยื่นขอสอบโครงการ      *    

20.  อนุมัติสอบโครงการ      *    

21.  สอบโครงการ      *    

22.  สงโครงการ         *   



 

 

3.2  การออกแบบ 

 

 3.2.1 โครงสรางของระบบเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.1 โครงสรางเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 



 

 

 3.2.2  แผนผัง Flowchart เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี  3.2  แผนผัง Flowchart เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

เร่ิมตน 

กําหนดคาแกส 

กําหนด 

คาแกส = 400 

ใช 

สถานะไฟสีแดงและมีเสียงเตือน 

ไม 
สถานะไฟสีเขียว 

จบการทํางาน 



 

 

 

 3.2.3  ออกแบบเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.3  เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 

 

 

 

 

 

 

 

 



 

 

 

3.3  การดําเนินการสราง 

 

  3.3.1  ตอสายจากบอรด Arduino ไปตอกับ โฟโตบอรด  

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.4  ตอสายจากบอรด Arduino ไปตอกับ โฟโตบอรด 

 

 3.3.2  นําตัวตานทานตอเขากับ โฟโตบอรด โดยที่ขาขางหน่ึงอยูดานลบ   

 

 

 

 

 

 

 

 

รูปท่ี 3.5 นําตัวตานทานตอเขากับ โฟโตบอรด 

 

 

 

 

 



 

 

 

 

 3.3.3  ตอ Gas Sensor เขากับตัวบอรด Arduino และ โฟโตบอรด 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.6  ตอ Gas Sensor เขากับตัวบอรด Arduino และ โฟโตบอรด 

 

 3.3.4  จากน้ันนํา LCD Display ตอเขากับตัวบอรด Arduino และ โฟโตบอรด 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.7  นํา LCD Display ตอเขากับตัวบอรด Arduino และ โฟโตบอรด 



 

 

 

3.3.5  ตอ Buzzer  เขากับโฟโตบอรด 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.8  ตอ Buzzer  เขากับโฟโตบอรด 

 

 3.3.6  ตอหลอดไฟ LED สีเขียวกับสีแดง เขากับโฟโตบอรด 

 

 

 

 

 

 

 

 

 

 

 

รูปท่ี 3.9  ตอหลอดไฟ LED สีเขียวกับสีแดง เขากับโฟโตบอรด 
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บทที่  4 

ผลการศึกษา 

 

 การจัดทําโครงการเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล น้ีมีวัตถุประสงคเพื่อสงเสริมการใช

โปรแกรม Arduino IDE เพื่อเขียนโปรแกรมควบคุม Arduino Arduino ใหเกิดประโยชนผูจัดทโครงงาน

สามารถนํามาประยุกตใชใหเขากับการเรียนรูของตนเองมากยิ่งขึ้นตลอดจนสามารถติดตอสื่อสารกันได

ระหวางครูเพื่อนและผูสนใจทั่วไป ซึ่งมีผลการดําเนินงานโครงงาน ดังน้ี 

 

4.1  ผลการพัฒนาโครงการ 

 การสรางเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล ผูจัดทําไดเร่ิมดําเนินงานตาม ขั้นตอนการ

ดําเนินงานที่เสนอในบทที่ 3 แลว จากน้ันไดนําเสนอเผยแพรผลงานผานทานคณะกรรมการ ซึ่งสามารถ

เชื่อมตอแจงเตือนและแสดงผลการทดลองในรูปแบบของ อุปกรณเคร่ืองตรวจจับและแจงเตือนแกส

ร่ั ว ไ ห ล  ส า ม า ร ถ เ รี ย น รู แ ล ะ ต อ บ คํ า ถ า ม  ไ ด เ ป น อ ย า ง ดี  โ ด ย ทั้ ง ค รู ที่ ป รึ ก ษ า 

เพื่อน ๆ ใน หองเรียนไดเขาไปมีสวนรวมในการจัดการเรียนรู โดยแสดงความเห็นในเน้ือหาและ

รูปแบบของการนําเสนออยางหลากหลาย ซึ่งทําใหเกิดการเรียนรูและเปนแหลงเรียนรูในของฮารดแวร

และซอฟตแวรคอมพิวเตอรอยางหลากหลายและรวดเร็ว 

 

4.2  ตัวอยางการนําเสนอเคร่ืองตรวจจับและแจงเตือนแกวร่ัวไหล 

 4.2.1  การออกแบบตัวอุปกรณเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล ซึ่งมีการคํานวณถึงลักษณะ

ขนาดที่ไมเล็กหรือใหญเกินไป มีหนาจอแสดงผลการแจงเตือนขอมูลและสัญญาณไฟพรอมเสียงแจง

เตือนเมื่อถึงคาที่กําหนดไวกับตัวอุปกรณ ดังตัวอยางรูปที่ 4.1 
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รูปท่ี 4.1  หนาที ่1 เปนหนาการออกแบบตัวอุปกรณเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 

 

 

 

 

 

 

 

รูปท่ี 4.2  หนาที่ 2 เปนหนาจอแสดงผลคาระดับแกสในอากาศที่กําลังลอยตัวอยูในอากาศ  เมื่อคาแกส

ในอากาศปกติจะแสดงสัญญาณไฟสีเขียว  ถาคาแกสในอากาศเกินที่กําหนดและสีสัญญาณไฟสีแดง

เตือนพรอมเสียง 
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บทที่  5 

สรุปผลและขอเสนอแนะการดําเนินโครงงาน 

 

ในการจัดทําโครงการเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล สามารถบรรลุวัตถุประสงค

ตามที่ผูจัดทําไดวางแผนไว ซึ่งเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลน้ันสามารถทํางานและการ

ประสบปญหาตาง ๆในที่ น้ีทางคณะผูจัดทําไดประสบปญหาในการทํางานหลายอยาง  จาก

โครงการและมีขอเสนอแนะที่จะนํามาใชปรับปรุงแกไขในสวนตาง ๆ จนทําใหมีผลการทํางานได

อยางมีประสิทธิภาพมากยิ่งขึ้น 

 

5.1  วัตถุประสงคของโครงการ 

5.1.1 เพื่อศึกษาสถานะ การทํางานของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

5.1.2 เพื่อนําเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลมาใชประโยชนไดจริง 

5.1.3 เพื่อสรางความปลอดภัยใหกับสถานที่ที่มีเคร่ืองมือหรือเคร่ืองใชที่บรรจุแกส 

5.1.4 เพื่อปองกันการเกิดอัคคีภัย 

 

5.2  ประโยชนท่ีคาดวาจะไดรับ 

5.2.1 ลดความเสี่ยงที่จะเกิดอัคคีภัยในสถานที่ที่มีเคร่ืองมือหรือเคร่ืองใชที่บรรจุแกส 

5.2.2 เพิ่มความปลอดภัยในชีวิตและทรัพยสิน 

5.2.3 ไดเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลที่สามารถใชงานไดจริง 

 

5.3  ปญหาท่ีประสบในการดําเนินโครงการ 

 การดําเนินการของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล น้ันทางคณะผูจัดทําไดประสบ

ปญหาการดําเนินโครงการหลายอยางในที่ น้ีทางคณะผูจัดทําโครงการจะอธิบายสาเหตุขอ ๆ ดังน้ี 

 5.3.1  ปญหาดานการออกแบบเคร่ืองตรวจจับ 

 5.3.2  ปญหาดานการศึกษาชุดคําสั่ง 

 5.3.3  ปญหาดานขั้นตอนในการทํางานของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 
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5.4  ผลการดําเนินโครงการ 

การดําเนินโครงการเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล เร่ิมต้ังแตการเสนอเร่ือง

โครงการตออาจารยหัวหนาสาขาวิชา ทางอาจารยไดหาขอมูลเพิ่มเติมเรียบรอย จึงไดรับการอนุมัติ

จากอาจารยหัวหนาสาขาวิชาในการสรางเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล แลวทําการศึกษา

หาขอมูล รายละเอียดของอุปกรณในการสรางเคร่ืองตรวจจับและแจงเตือน แลวจึงวางแผนการ

ดําเนินโครงการ โดยการออกแบบโครงสรางของระบบเคร่ืองตรวจจับและแจงเตือน แลวทําแผนผัง 

Flowchart  แลวออกแบบตัวเคร่ือง และติดต้ังระบบแลวทําการทดสอบ เปนตน 

 ผลการดําเนินโรงการเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล สามารถบอกคาของแกสผาน

จอ LCD มีสัญญาณไฟสีแดงในการบอกวาคาของแกสเกินกําหนดอยูในสถานะอันตราย และมีเสียง

ในการแจงเตือน เปนตน 

  

5.5  อภิปรายผล 

จากผลของการดําเนินโครงการน้ีถือวาประสบความสําเร็จตามที่ต้ังจุดประสงคไว คือ เคร่ือง

ตรวจจับและแจงเตือนแกสร่ัวไหล สามารถตรวจจับแกสที่ร่ัวไหลในอากาศ โดยมีการแสดงผลปริ

มานแกสที่ตรวจจับไดบนจอแสดงผลLCD และสามารถกําหนดคาแกสไดในโปรแกรม Arduino 

เมื่อมีปริมานแกสเกินคาที่กําหนดไวจะทําใหลําโพงดังขึ้นและมีสัญญาณไฟสีแดงสวางขึ้น เพื่อแจง

เตือนวามีแกสร่ัวไหล และเมื่อปริมานแกสมีปริมานนอยกวาคาที่กําหนดไว ก็จะไมมีสัญญาณเสียง

ดังขึ้นและสัญญาณไฟสีเขียวจะสวางขึ้นมา 

 

5.6  ขอเสนอแนะ 

5.6.1  ขอเสนอแนะทั่วไป 

 5.6.1.1 เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลควรมี Volume ปรับคาได 

 5.6.1.2 เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลควรมีพัดลมดูดอากาศเพื่อชวยในการ

ตรวจจับที่   ดีขึ้น  

 5.6.1.3 เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลถาเปนไปไดควรใช Sensor ที่ใหญขึ้น

และเพิ่มทิศทางการตรวจจับ เพื่อเพิ่มประสิทธิภาพในการตรวจจับ 

5.6.2  ขอเสนอแนะทางเทคนิค 

 5.6.2.1 เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลควรจัดการเรียงลําดับการทํางานของ 

code ชุดคําสั่งใหถูกตอง 

 5.6.2.2 เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลควรออกแบบใหตัวเคร่ืองติดต้ังงาย 

สะดวกตอการเคลื่อนยาย มีขนาดที่พอเหมาะ 
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แบบเสนอรางโครงการ 

สาขาวิชาเทคโนโลยีสารสนเทศ 

 

ชื่อโครงการ เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

  Gas leak detector and alarm  

ชื่อผูเสนอโครงการ 1.  นายธีรพงศ    ธูปขุนทด รหัสประจําตัว 37250 (หัวหนากลุมโครงการ) 

ชื่อผูรวมโครงการ 2.  นายไชยรัตน  จากรัมย   รหัสประจําตัว 37239 

 

นักศึกษาสาขาวิชาเทคโนโลยีสารสนเทศ  รอบบาย* 

ชื่ออาจารยที่ปรึกษาโครงการ อาจารย คุณานนท สุขเกษม 

ชื่ออาจารยที่ปรึกษารวม อาจารยสุธารัตน ทองใหม 

 

 มีความประสงคขออนุมัติหัวขอโครงการ  เพื่อเปนสวนหน่ึงของการศึกษาตามหลักสูตร

ประกาศนียบัตรวิชาชีพชั้นสูง  ในวิชาโครงการ  จํานวน  4  หนวยกิต 

 

 จึงเรียนมาเพื่อโปรดพิจารณา  ดังรายละเอียดโครงการที่แนบมาดวย 

 

ลงชื่อ  นายธีรพงศ ธูปขุนทด  (หัวหนากลุมโครงการ) 

ลงชื่อ  นายไชยรัตน จากรัมย  (สมาชิกกลุมโครงการ) 

...................... / ............................ / .............. 

ความเห็นอาจารยที่ปรึกษาโครงการ 

..............................................................................

..............................................................................

..............................................................................

.                                    

               ลงนาม ................................................. 

                                ............ /.................. / .......... 

                ลงนาม ................................................. 

                                ............ /.................. / .......... 

ความเห็นผูรับผิดชอบโครงการ  สาขาวิชาฯ 

...........................................................................

...........................................................................

...........................................................................

.                                 

               ลงนาม ............................................... 

                                ............ /................ / ......... 

 

หมายเหตุ  พรอมแนบโครงการ  ตามแบบฟอรมที่กําหนดมาดวยแลว 
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1.  ชื่อโครงการ เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

  Gas leak detector and alarm 

2.  ความเปนมาและความสําคัญของปญหา 

  ในอดีตที่ผานมามีการใชคอมพิวเตอรเพื่อนํามาใชงานดานตาง ๆ อยางแพรหลาย และ ใช

โปรแกรม Arduino IDE เพื่อเขียนโปรแกรมควบคุม Arduino เพื่อนําไปควบคุมอุปกรณ

อิเล็กทรอนิกส ในการใชงานดานตาง ๆ แตเน่ืองจากการพัฒนาของเทคโนโลยีในปจจุบันมี

ความกาวหนาอยางรวดเร็ว จึงทําใหชุดซอฟตแวรและอุปกรณอิเล็กทรอนิกสมีการพัฒนามากยิ่งขึ้น

มีความทันสมัยใชงานงาย และมีใหเลือกอยางหลากหลายโปรแกรมที่ใชงานและสามารถนํามา

พัฒนาและประยุกตใชไดอยางหลากหลาย 

  เปนที่ทราบกันดีอยูแลววา ความปลอดภัยน้ันเปนสิ่งสําคัญตอการดําเนินชีวิต ในปจจุบัน

ระบบรักษาความปลอดภัยไดเขามามีบทบาทสําคัญในการปองกันอุบัติเหตุที่จะเกิดขึ้นอยางไม

คาดคิด ควบคูไปกับเทคโนโลยีที่กําลังจะถูกพัฒนาอยางไมหยุดน่ิง เพื่อลดความสูญเสียที่จะเกิดขึ้น

จากปญหาที่พบแกสร่ัวไหลอาจนํามาสูการเกิดเพลิงไหม เกิดการระเบิด ซึ่งทําใหเกิดความสูญเสีย 

เสียทรัพยสิน เสียทรัพยากร หรืออาจถึงขั้นเกิดการเสียชีวิต ทําใหเกิดแนวคิดในการจัดทํา

เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล ที่สามารถแจงเตือนขณะมีแกสร่ัวไหล สามารถแสดงผาน

ทางจอภาพถึงระดับของแกสที่ร่ัวไหลออกมา สามารถเลือกระดับปริมาณของแกสที่จะทําการแจง

เตือนและสามารถแกไขปญหาการร่ัวไหลของแกสไดทันเวลา ซึ่งการทํางานทั้งหมดน้ันจะถูก

ควบคุมโดย Arduino หลักการทํางานของชุดอุปกรณเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลจะ

ทํางานโดยเขียนชุดคําสั่งใหโปรแกรมทํางานผาน Arduino เพื่อใหควบคุมอุปกรณเคร่ืองตรวจจับ

และแจงเตือนแกสร่ัวไหล ใหทํางานตามความตองการของผูใช ซึ่งโปรแกรมในปจจุบันน้ีถูก

พัฒนาขึ้นมาเพื่อตอบสนองความตองการในการใชงานของมนุษยมากที่สุดและมีประสิทธิภาพใน

การใชงานสูงสุด และใชงานงายกวาโปรแกรมในอดีต 

  จึงมีการนําเสนอ โครงการเร่ืองเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล เน่ืองจากผูเสนอ

โครงการพบปญหาที่เกิดขึ้น จึงมีแนวคิดที่จะพัฒนาเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลน้ีให

สามารถตรวจจับปริมาณแกสได มีการแสดงผลทางจอ LCD และมีลําโพงแจงเตือน คณะผูจัดทํา

โครงการน้ีมีความตองการที่จะพัฒนาตอยอดใหชิ้นงานน้ันมีประสิทธิภาพที่ดีขึ้น และเสริมสราง

ทักษะทางดานการเขียนโปรแกรมของคณะผูจัดทําและดานความคิดสรางสรรคในดานการออกแบบ

โครงสรางของชิ้นงาน ทําใหผูจัดทํามีประสบการณและเสริมสรางทักษะทั้งในดาน ซอฟตแวร และ 

ฮารดแวร ไปพรอม ๆ กัน สงเสริมใหมีความเชียวชาญมากขึ้นมีไหวพริบในการแกไขปญหาเฉพาะ

หนามีความรับผิดชอบ และเปนการสงเสริมใหหันมาสนใจทางดานฮารดแวรมากยิ่งขึ้น 
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3.  วัตถุประสงคของโครงการ 

 3.1 เพื่อศึกษาสถานการณทํางานของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 3.2 เพื่อนําเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลมาใชประโยชนไดจริง 

 3.3 เพื่อสรางความปลอดภัยใหกับสถานที่ที่มีเคร่ืองมือหรือเคร่ืองใชที่บรรจุแกส 

 3.4 เพื่อปองกันการเกิดอัคคีภัย 

 

4.  ขอบเขตของโครงการ 

 4.1 เคร่ืองตรวจจับและแจงเตือนแกสไวไฟร่ัวไหล ที่สามารถตรวจจับและแจงเตือนได              

โดยใชจอ LCD ในการแสดงผลปริมาณของแกสในอากาศ 

 4.2 เคร่ืองตรวจจับและแจงเตือนแกสไวไฟร่ัวไหล จะแสดงสถานะการทํางานโดยมีสัญญาณ

ไฟสีเขียว คือ สถานะการทํางานปกติ เมื่อเคร่ืองตรวจพบปริมาณแกสในอากาศเกินคาที่กําหนด         

จะแสดงสัญญาณไฟสีแดง และมีเสียงสัญญาณแจงเตือนเมื่อพบปริมาณแกสในอากาศเกินคาที่

กําหนด 

 4.3 เคร่ืองตรวจจับและแจงเตือนแกสไวไฟร่ัวไหล ที่สามารถชวยลดการเกิดอัคคีภัย                 

ในครัวเรือน 

 

5.  ข้ันตอนการดําเนินงาน 

5.1  คิดหัวขอโครงการ  

5.2  จัดทําเอกสารแบบเสนอรางโครงการ 

5.3  เสนอโครงการ 

5.4  แบงหนาที่ความรับผิดชอบ 

5.5  ศึกษาคนควาขอมูลเกี่ยวกับบอรดArduinoและชุดซอฟตแวรที่จะใชควบคุม 

5.6  ศึกษาขั้นตอนการใสโคด 

5.7  ออกแบบเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

5.8  จัดทํารูปเลมโครงการบทที่ 1 

5.9  จัดทํารูปเลมโครงการบทที่ 2 

5.10  จัดทํารูปเลมโครงการบทที่ 3 

5.11  สอบโครงการบทที่ 1-3 

5.12  ปรับปรุงและแกไข 

5.13  จัดเตรียมเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

5.14  ใสโคดลงบอรดArduino ผานโปรแกรม Arduino IDE 
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5.15  ทดสอบการทํางานของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

5.16  ตรวจสอบความเรียบรอย 

5.17  สอบโครงการเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

5.18  จัดทํารูปเลมโครงการบทที่ 5 

5.19  จัดทํารูปเลมโครงการบทที่ 4 

5.20  จัดทํารูปเลมโครงการฉบับสมบูรณ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
เร่ิมตน 
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รูปท่ี1.1 แผนภาพ Flowchart ขั้นตอนการดาเนินงาน 

 

 

 

คิดหัวขอโครงการ 

จัดทําเอกสารแบบเสนอราง

โครงการ 

เสนอราง

โครงการ

 

ศึกษาคนควาขอมูล 

ผาน 

ไมผาน 

จัดทําโครงการ สรางเคร่ืองมือ 

รวบรวมขอมูล 

แกไข 

A 

A 
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รูปท่ี 1.1 แผนภาพ Flowchart ขั้นตอนการดาเนินงาน (ตอ) 

6. ระยะเวลาการทําโครงการ  

ลํา

ั  

ข้ันตอนการดําเนินงาน ระยะเวลาการดําเนินงาน 

แกไขปรับปรุงเคร่ืองตรวจจับ

และแจงเตือนแกสร่ัวไหล 

วิเคราะหและรวบรวมขอมูล 

นําเสนอโครงการ 

สิ้นสุดการ

 

นําเสนอ

โครงการผาน

 
ผาน 

ไมผาน 

จัดทํารูปเลมโครงการทั้งหมด 

ทดลองใชเคร่ืองตรวจจับและ

แจงเตือนแกสร่ัวไหล 

แกไข 
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 ตารางที่ 1.1 ตารางแผนการดําเนินงาน  

 

ป พ.ศ. 2562 ป พ.ศ. 2563 

มิ.ย ก.ค ส.ค ก.ย ต.ค พ.ย ธ.ค ม.ค ก.พ 

1 คิดหัวขอโครงการ          

2 จัดทําเอกสารแบบเสนอราง          

3 เสนอรางโครงการ          

4 แกไขเสนอรางโครงการ          

5 สงเสนอรางโครงการที่แกไข

แลว 

         

6 ศึกษาคนควาขอมูลเกี่ยวกับ

บอรดArduinoและชุด

ซอฟตแวรที่จะใชควบคุม 

         

7 วางแผนการทํางานกระจาย

งานแบงการทํางานเปนสวน ๆ 

         

8 จัดทําโครงการ สรางเคร่ืองมือ

และรวบรวมขอมูล 

         

9 ทดลองใชเคร่ืองตรวจจับและ

แจงเตือนแกสร่ัวไหล 

         

10 แกไขปรับปรุงเคร่ืองตรวจจับ

และแจงเตือนแกสร่ัวไหล 

         

11 นําเสนอโครงการ          

12 จัดทํารูปเลมโครงการทั้งหมด          
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7.  ประโยชนท่ีคาดวาจะไดรับ 

 7.1  ลดความเสี่ยงที่จะเกิดอัคคีภัยในสถานที่ที่มีเคร่ืองมือหรือเคร่ืองใชที่บรรจุแกส  

 7.2  เพิ่มความปลอดภัยในชีวิตและทรัพยสิน 

 7.3  ไดเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหลที่สามารถใชงานไดจริง 

 

8.  งบประมาณท่ีใชในการทําโครงการ 

 1. Sensor MQ-5            100 บาท 

 2. ตัวตานทาน คาความตานทานที่ 220 Ohm 20   บาท 

 3. LCD Display    200 บาท 

 4. Arduino UNO    450 บาท 

 5. ลําโพงขนาดเล็ก (Buzzer)   40   บาท 

 6. หลอดไฟ LED สีเขียว สีแดง   80   บาท 

 7. สายไฟ ชนิด Male to Male    40   บาท 

  8.  สายไฟ ชนิด Male to Female                     40   บาท 

         9. โฟโตบอรด    100 บาท 

         10. คาทําเลมเอกสาร   500 บาท 

 

        รวม    1570  บาท 

 

9.  เอกสารอางอิง  

 http://gas-lpg-alam-sensor.blogspot.com/2017/02/lpg-gas-alam-sensor.html 

 http://lpg-gas-alam-sensor.blogspot.com/2016/11/lpg-gas-alam-sensor.html 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาคผนวก  ข 

แบบประเมินความกาวหนา 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



แบบประเมิณความกาวหนาโครงการ 

 

เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

Gas leak detector and alarm 

 

 

 

 

 

 

 

 

ชื่อผูจัดทํา 

 นายธีรพงศ      ธูปขุนทด   รหัสประจําตัว  37250 

 นายไชยรัตน    จากรัมย    รหัสประจําตัว  37239 

 

 

 

 

 

 

 

 

ภาคเรียนที่ 1/2562 

สาขาวิชาเทคโนโลยีสารสนเทศ   

วิทยาลัยเทคโนโลยีอรรถวิทยพณิชยการ  
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แบบฟอรมประเมินความกาวหนาโครงการ 

 

ชื่อโครงการ เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

ชื่อโครงการ   Gas leak detector and alarm 

ปการศึกษา 2562 

 

ชื่อผูจัดทําโครงการ (1) นายธีรพงศ ธูปขุนทด รหัสประจําตัว 37250 ชั้น ปวส.2 

 (2) นายไชยรัตน จากรัมย  รหัสประจําตัว 37239 ชั้น ปวส.2 

     

ชื่ออาจารยท่ีปรึกษาโครงการ      อาจารย คุณานนท  สุขเกษม 

ชื่ออาจารยท่ีปรึกษาโครงการรวม       อาจารยสุธารัตน ทองใหม 

 

โครงการน้ีจัดอยูในกลุมของ 

 Web Programming  Computer Multimedia 

  Computer Programming  Database System 

  Hardware  Computer  …………………………… 

 

ขอบเขตของโครงการท้ังหมด  

เคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล ไดมีการกําหนดขอบเขตของการทํางาน มีดังตอไปน้ี 

1.  มีสัญญาณแจงเตือนโดยใชลําโพงเปนตัวสงเสียงสัญญาณเมื่อมีแกสร่ัวไหลเกิดขึ้น 

2.  ตัวระบบเซนเซอร สามารถตรวจจับแกสที่ร่ัวไหล ตามปริมาณที่กําหนดไวไดอยาง

เสถียร 

3.  การแสดงผลปริมาณของแกส แสดงผานจอ LCD  

4.  สามารถกดปดสัญญาณแจงเตือน โดยใชสวิตชเขามาใชในการปดการแจงเตือนที่ดังขึ้น 

5.  ใชพัดลมดูดอากาศ เพื่อดูดแกสที่อยูในอากาศเขามาที่เซ็นเซอร ทําใหเคร่ืองตรวจจับ

และแจง 

เตือนแกสร่ัวไหลเกิดความเสถียรใหไดมากที่สุด 

6.  สามารถปองกันและลดความเสี่ยงที่จะเกิดเหตุการณที่ไมคาดคิด เน่ืองมาจากแกสที่

ร่ัวไหล 
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รายงานผลความกาวหนาของโครงการ  25% 

 

รายละเอียดของหัวขอท่ีรายงานผลความกาวหนา ผาน ไมผาน เหตุผล (กรณีไมผาน) 

1. รวบรวมขอมูล    

2. ศึกษาขอมูล    

3. วิเคราะหงาน    

4. ออกแบบโครงสรางเคร่ืองตรวจจับ 

- ระบบตรวจจับจากเซ็นเซอร 

- ระบบแจงเตือนจากลําโพงและ

สัญญาณไฟ 

   

5. โครงการ  บทที่ 1    

6. โครงการ  บทที่ 2 (บางสวน)    

 
 

การประเมินผลความกาวหนาของโครงการโดยอาจารยท่ีปรึกษา 

 ผาน  ไมผาน 

ขอช้ีแจงของอาจารยที่ปรึกษา (กรณีที่อาจารยที่ปรึกษาประเมินไมผาน)   

……………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………. 

     ลายเซ็น ………………………………………..……… 

      (อาจารยคุณานนท สุขเกษม) 

อาจารยท่ีปรึกษา 

           วันที่  …….. / …………………. / 25…. 
 

การประเมินผลความกาวหนาของโครงการโดยอาจารยท่ีปรึกษารวม 

 ผาน  ไมผาน 

ขอช้ีแจงของอาจารยที่ปรึกษา (กรณีที่อาจารยที่ปรึกษาประเมินไมผาน)   

……………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………. 

     ลายเซ็น ………………………………………..……… 

      (อาจารยสุธารัตน ทองใหม) 

อาจารยท่ีปรึกษารวม 

           วันที่  …….. / …………………. / 25…. 
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______________________________________________________________________________ 

การประเมินผลความกาวหนาของโครงการโดยกรรมการ 

 ผาน  ไมผาน 

ความคิดเห็นของกรรมการ (กรณีที่กรรมการประเมินไมผาน)   

……………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………. 

     ลายเซ็น ………………………………………..……… 

         (          ) 

กรรมการตรวจสอบ 

           วันที่  …….. / …………………. / 25…. 
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รายงานผลความกาวหนาของโครงการ  50% 

 

รายละเอียดของหัวขอท่ีรายงานผลความกาวหนา ผาน ไมผาน เหตุผล (กรณีไมผาน) 

7. ออกแบบเคร่ืองตรวจจับและแจงเตือนแกส

ร่ัวไหล 

   

8. จัดทําเอกสารโครงการบทที่ 2 ในสวนที่เหลือ    

9. จัดทําเอกสารโครงการบทที่ 3    

10. จัดทําเคร่ืองตรวจจับและแจงเตือนแกส

ร่ัวไหล 

   

 

การประเมินผลความกาวหนาของโครงการโดยอาจารยท่ีปรึกษา 

 ผาน  ไมผาน 

ขอช้ีแจงของอาจารยที่ปรึกษา (กรณีที่อาจารยที่ปรึกษาประเมินไมผาน)   

……………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………. 

     ลายเซ็น ………………………………………..……… 

      (อาจารยคุณานนท สุขเกษม) 

อาจารยท่ีปรึกษา 

           วันที่  …….. / …………………. / 25…. 
 

การประเมินผลความกาวหนาของโครงการโดยอาจารยท่ีปรึกษารวม 

 ผาน  ไมผาน 

ขอช้ีแจงของอาจารยที่ปรึกษา (กรณีที่อาจารยที่ปรึกษาประเมินไมผาน)   

……………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………. 

     ลายเซ็น ………………………………………..……… 

      (อาจารยสุธารัตน ทองใหม) 

อาจารยท่ีปรึกษารวม 

           วันที่  …….. / …………………. / 25…. 
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______________________________________________________________________________ 

การประเมินผลความกาวหนาของโครงการโดยกรรมการ 

 ผาน  ไมผาน 

ความคิดเห็นของกรรมการ (กรณีที่กรรมการประเมินไมผาน)   

……………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………. 

     ลายเซ็น ………………………………………..……… 

         (          ) 

กรรมการตรวจสอบ 

           วันที่  …….. / …………………. / 25…. 
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รายงานผลความกาวหนาของโครงการ 75% 

 

รายละเอียดของหัวขอท่ีรายงานผลความกาวหนา ผาน ไมผาน เหตุผล (กรณีไมผาน) 

11. ใสโคดลงในโปรแกรม Arduino IDE    

12. จัดวางอุปกรณเคร่ืองตรวจจับและแจงเตือน

แกสร่ัวไหลใหสมบูรณ 

   

13. จัดทําเอกสารโครงการบทที่ 4    

 

การประเมินผลความกาวหนาของโครงการโดยอาจารยท่ีปรึกษา 

 ผาน  ไมผาน 

ขอช้ีแจงของอาจารยที่ปรึกษา (กรณีที่อาจารยที่ปรึกษาประเมินไมผาน)   

……………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………. 

     ลายเซ็น ………………………………………..……… 

      (อาจารยคุณานนท สุขเกษม) 

อาจารยท่ีปรึกษา 

           วันที่  …….. / …………………. / 25…. 
 

การประเมินผลความกาวหนาของโครงการโดยอาจารยท่ีปรึกษารวม 

 ผาน  ไมผาน 

ขอช้ีแจงของอาจารยที่ปรึกษา (กรณีที่อาจารยที่ปรึกษาประเมินไมผาน)   

……………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………. 

     ลายเซ็น ………………………………………..……… 

      (อาจารยสุธารัตน ทองใหม) 

อาจารยท่ีปรึกษารวม 

           วันที่  …….. / …………………. / 25…. 
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______________________________________________________________________________ 

การประเมินผลความกาวหนาของโครงการโดยกรรมการ 

 ผาน  ไมผาน 

ความคิดเห็นของกรรมการ (กรณีที่กรรมการประเมินไมผาน)   

……………………………………………………………………………………………………………………. 

……………………………………………………………………………………………………………………. 

     ลายเซ็น ………………………………………..……… 

         (          ) 

กรรมการตรวจสอบ 

           วันที่  …….. / …………………. / 25…. 
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รายงานผลความกาวหนาของโครงการ 100% 

 

รายละเอียดของหัวขอท่ีรายงานผลความกาวหนา หมายเหตุ 

14. ทดสอบเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล  

15. จัดทําเอกสารโครงการบทที่ 5  

16. แกไขและสรุประบบงาน  

17. รูปเลมโครงการฉบับสมบูรณ  

18. ขอสอบโครงการ  

 

หมายเหตุ  รายงานผลความกาวหนาของโครงการ 100% จะอยูชวงหลังจากสอบนําเสนอโครงการ

ไปแลว 
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บันทึกการเขาพบอาจารยท่ีปรึกษา 

 

วัน / เดือน / ป ลายเซ็นอาจารยท่ีปรึกษา หมายเหตุ 

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

 

 



 

 

 

 

 

  

 

 

 

 

 

 

 

 

ภาคผนวก  ค 

คูมือการใชงานเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 
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 1.   ตัวอุปกรณเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล จะมีหนาจอแสดงคาแกส สัญญาณไฟ

สีเขียวและสีแดง ตัวกลอง ลําโพง และเซ็นเซอรตรวจจับแกส ดังตัวอยางรูปที่ 1 

 

 

 

 

 

 

 

 

รูปท่ี 1  หนาที่ 1 เปนตัวอุปกรณเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 

2.  หนาจอแสดงผลคาแกส แอลพีจี ที่ลอยตัวอยูในอากาศ โดยหนวยวัดคาแกสคือ PPM         

ดังตัวอยางรูปที่ 4.2 

 

 

 

 

 

 

 

 

รูปท่ี 2  หนาที่ 2 หนาจอแสดงผลคาแกส   
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3.  แสดงหนาการทํางานของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล สัญญาณไฟสีเขียวคือ

สถานะคาแกสปกติ  สัญญาณไฟสีแดงคือสถานะคาแกสเกินที่กําหนด ดังตัวอยางรูปที่ 4.3 

 

 

 

 

 

 

รูปท่ี 3.  หนาที่ 3 แสดงหนาการทํางานของเคร่ืองตรวจจับและแจงเตือนแกสร่ัวไหล 

 

 



 

 

 

 

 

  

 

 

 

 

 

 

 

 

ภาคผนวก  ง 

ประวัติผูเขียน 
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ประวัติผูเขียน 

 

ชื่อ – สกุล   นายธีรพงศ ธูปขุนทด 

วันเดือนป 8 มีนาคม 2542 

สถานที่เกิด พิษณุโลก 

สถานที่อยูปจจุบัน 1686 หมู 3 ตําบล สําโรงเหนือ อําเภอ เมือง  จังหวัด สมุทรปราการ 

สถานที่ศึกษา วิทยาลัยเทคโนโลยีอรรถวิทยพณิชยการ บางนา 

ประวัติการศึกษา  

พ.ศ. 2557 โรงเรียนมหาภาพกระจาดทองอุปถัมภ 

พ.ศ. 2558 – ปจจุบัน วิทยาลัยเทคโนโลยีอรรถวิทยพณิชยการ บางนา 

 

ผลงานและกิจกรรม 

พ.ศ. 2561 ไดเขารวมทัศนศึกษาที่ Thai Summit Thailand 

พ.ศ. 2562 เขารวมแขงขันกีฬาภายในวิทยาลัยเทคโนโลยีอรรถวิทยพณิชยการ 

พ.ศ. 2563 เขารวมอบรมขับขี่ปลอดภัย Honda Thailand  
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ชื่อ – สกุล นายไชยรัตน จากรัมย 

วันเดือนป 23 มีนาคม 2542 

สถานที่เกิด กรุงเทพมหานคร 

สถานที่อยูปจจุบัน 3906  ซอย ดานสําโรง40/2 ถนน สุขุมวิท ตําบล สําโรงเหนือ             

อําเภอ เมือง จังหวัดสมุทรปราการ 

สถานที่ศึกษา วิทยาลัยเทคโนโลยีอรรถวิทยพณิชยการ บางนา  

ประวัติการศึกษา  

พ.ศ. 2557 โรงเรียนมหาภาพกระจาดทองอุปถัมภ  

พ.ศ. 2558 – ปจจุบัน วิทยาลัยเทคโนโลยีอรรถวิทยพณิชยการ บางนา 

 

ผลงานและกิจกรรม 

พ.ศ. 2560 เปนตัวแทนไปแขงขัน เกม FIFA ONLINE ไดรับรางวัลรองชนะเลิศ

อันดับที่ 1 

พ.ศ. 2561 เขารวมแขงขันกีฬาฟุตซอลภายใน ไดรับรางวัลชนะเลิศอับดับที่ 1 

พ.ศ. 2562 ไดรับทุนเรียนดีเยี่ยมสาขาวิชาเทคโนโลยีสารสนเทศ ภาควันอาทิตย 

 

 

 

 

  
 

 
 
 

 

ประวัติผูเขียน 
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